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Chapter 1. Troubleshooting basics
To troubleshoot a problem, gather information about the problem for IBM Software Support, use logging
data, and consult the lists of identified problems and workarounds.

For general troubleshooting information, see the IBM Tivoli Monitoring Troubleshooting Guide. For other
problem-solving options, see Chapter 4, “Support information,” on page 45.

You can resolve some problems by ensuring that your system matches the system requirements. The
most up-to-date requirements are in the Software product compatibility reports (http://
publib.boulder.ibm.com/infocenter/prodguid/v1r0/clarity/index.html).

The following activities can help you find a solution to the problem you are having:

• “Gathering product information for IBM Software Support” on page 1
• “Using logging” on page 2
• “Consulting the lists of identified problems and workarounds” on page 2

Gathering product information for IBM Software Support

Before contacting IBM Software Support about a problem you are experiencing with this product, gather
the information shown in Table 1 on page 1.

Table 1. Information to gather before contacting IBM Software Support

Information type Description

Log files Collect trace log files from failing systems. Most
logs are located in a logs subdirectory on the host
computer. See “Principal trace log files” on page
4 for lists of all trace log files and their locations.

For general information about the IBM Tivoli
Monitoring environment, see the Tivoli Enterprise
Portal User's Guide.

DB2 Universal Database information Version number and patch level

Sample application data file (if monitoring a file)

Operating system Operating system version number and patch level

Messages Messages and other information displayed on the
screen

Version numbers for IBM Tivoli Monitoring Version number of the following members of the
monitoring environment:

• IBM Tivoli Monitoring. Also provide the patch
level, if available.

• DB2 agent

Screen captures Screen captures of incorrect output, if any

(UNIX systems only) Core dump files If the system stops on UNIX systems, collect the
core dump file from the install_dir/bin
directory, where install_dir is the directory
where you installed the monitoring agent.
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You can use the pdcollect tool to collect the most commonly used information from a system. This tool
gathers log files, configuration information, version information, and other data. For more information
about using this tool, see "pdcollect tool" in the IBM Tivoli Monitoring Troubleshooting Guide.

For information about working with IBM Software Support, see IBM Support Portal Service Requests and
PMRs (http://www.ibm.com/support/entry/portal/Open_service_request/Software/
Software_support_(general)).

Using logging

Logging is the primary troubleshooting feature in the monitoring agent. Logging refers to the text
messages and trace data that is generated by the agent. Messages and trace data are sent to a file.

Trace data captures transient information about the current operating environment when a component or
application fails to operate as designed. IBM Software Support personnel use the captured trace
information to determine the source of an error or unexpected condition. See Chapter 2, “Trace logging,”
on page 3 for more information.

Consulting the lists of identified problems and workarounds

Known problems are organized into types such as those in the following list to make them easier to
locate:

• Installation, configuration, uninstallation
• Remote deployment
• Agent
• Workspace
• Situation
• Take Action commands

SeeChapter 3, “Problems and workarounds,” on page 15 for information about symptoms and detailed
workarounds for these types of problems.

For general troubleshooting information, see the IBM Tivoli Monitoring Troubleshooting Guide.
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Chapter 2. Trace logging

Trace logs capture information about the operating environment when component software fails to
operate as intended. The principal log type is the RAS (Reliability, Availability, and Serviceability) trace
log. These logs are in the English language only. The RAS trace log mechanism is available for all
components of IBM Tivoli Monitoring. Most logs are located in a logs subdirectory on the host computer.

Important: The documentation refers to the RAS facility in IBM Tivoli Monitoring as "RAS1".

IBM Software Support uses the information captured by trace logging to trace a problem to its source or
to determine why an error occurred. The default configuration for trace logging, such as whether trace
logging is enabled or disabled and trace level, depends on the source of the trace logging. Trace logging is
always enabled.

Overview of log file management
“Principal trace log files” on page 4 provides the names, locations, and descriptions of RAS1 log files.
The log file names adhere to the following naming convention:

• Windows systems:

  hostname_product_instance_program_timestamp-nn.log

• UNIX and Linux® systems

  hostname_product_program_timestamp-nn.log

where:

• hostname is the host name of the computer on which the monitoring component is running.
• product is the two-character product code. For DB2 agent, the product code is ud.
• instance is the name of the database instance that is being monitored.
• program is the name of the program being run.
• timestamp is an eight-character hexadecimal timestamp representing the time at which the program

started.
• nn is a rolling log suffix. See “Examples of trace logging” on page 3 for details of log rolling.

Examples of trace logging
For example, if a DB2 Universal Database instance "dbinst02" is running on computer "server01", the RAS
log file for the DB2 agent might be named as follows:

server01_ud_dbinst02_kudcma_437fc59-01.log

Important: These examples show log names on Windows systems, where the program is named
kudcma.

For long-running programs, the nn suffix is used to maintain a short history of log files for that startup of
the program. For example, the kudcma program might have a series of log files as follows:

server01_ud_dbinst02_kudcma_437fc59-01.log
server01_ud_dbinst02_kudcma_437fc59-02.log
server01_ud_dbinst02_kudcma_437fc59-03.log

As the program runs, the first log (nn=01) is preserved because it contains program startup information.
The remaining logs "roll." In other words, when the set of numbered logs reach a maximum size, the
remaining logs are overwritten in sequence. Each time a program is started, a new timestamp is assigned
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to maintain a short program history. For example, if the DB2 agent is started twice, it might have log files
as follows:

server01_ud_dbinst02_kudcma_437fc59-01.log
server01_ud_dbinst02_kudcma_437fc59-02.log
server01_ud_dbinst02_kudcma_437fc59-03.log

server01_ud_dbinst02_kudcma_537fc59-01.log
server01_ud_dbinst02_kudcma_537fc59-02.log
server01_ud_dbinst02_kudcma_537fc59-03.log

Each program that is started has its own log file. For example, the DB2 agent would have agent logs in this
format:

server01_ud_dbinst02_kudcma_437fc59-01.log

Other logs, such as logs for collector processes and Take Action commands, have a similar syntax, as in
the following example:

server01_ud_dbinst02_kudBackupDatabase_447fc59-01.log

where kudBackupDatabase is the name of a program.

Remember: When you communicate with IBM Software Support, you must capture and send the RAS1
log that matches any problem occurrence that you report.

Principal trace log files
Trace log files are located on various systems.

Table 2 on page 4 contains locations, file names, and descriptions of trace logs that can help determine
the source of problems with agents.

Table 2. Trace log files for troubleshooting agents

System where log is located File name and path Description

On the Tivoli Enterprise
Monitoring Server

• Windows: The IBM Tivoli
Monitoring
timestamp.log file in the
install_dir\InstallITM
path

• UNIX: The
candle_installation.log
file in the install_dir/logs
path

• Linux: The
candle_installation.log
file in the install_dir/logs
path

Provides details about products
that are installed.

Note: Trace logging is enabled by
default. A configuration step is
not required to enable this
tracing.

On the Tivoli Enterprise
Monitoring Server

The
Warehouse_Configuration.l
og file is in the following location
on Windows systems:
install_dir\InstallITM

Provides details about the
configuration of data
warehousing for historical
reporting.
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Table 2. Trace log files for troubleshooting agents (continued)

System where log is located File name and path Description

On the Tivoli Enterprise
Monitoring Server

The name of the RAS log file is as
follows:

• Windows: install_dir
\logs
\hostname_ms_timestamp-
nn.log

• UNIX: install_dir/logs/
hostname_ms_timestamp-
nn.log

• Linux: install_dir/logs/
hostname_ms_timestamp-
nn.log

Note: File names for RAS1 logs
include a hexadecimal time
stamp.

Also on UNIX systems, a log with
a decimal time stamp is
provided:
hostname_ud00_timestamp.l
og and
hostname_ud00_timestamp.p
idnnnnn in the install_dir/
logs path, where nnnnn is the
process ID number.

Traces activity on the monitoring
server.

On the Tivoli Enterprise Portal
Server

The name of the RAS log file is as
follows:

• Windows: install_dir
\logs\
hostname_cq_HEXtimestam
p-nn.log

• UNIX: install_dir/logs/
hostname_cq_HEXtimestam
p-nn.log

• Linux: install_dir /logs/
hostname_cq_HEXtimestam
p-nn.log

Note: File names for RAS1 logs
include a hexadecimal time
stamp.

Also on UNIX systems, a log with
a decimal time stamp is
provided:
hostname_ud00_timestamp.l
og and
hostname_ud00_timestamp.p
idnnnnn in the install_dir/
logs path, where nnnnn is the
process ID number.

Traces activity on the portal
server.
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Table 2. Trace log files for troubleshooting agents (continued)

System where log is located File name and path Description

On the Tivoli Enterprise Portal
Server

The teps_odbc.log file is
located in the following path:

• Windows: install_dir
\InstallITM

• UNIX: install_dir/logs
• Linux: install_dir/logs

When you enable historical
reporting, this log file traces the
status of the warehouse proxy
agent.

On the computer that hosts the
monitoring agent

The RAS1 log files are as follows:

• Windows: hostname
_ud00_instance_name_kud
00agent_
HEXtimestamp-nn.log in the
install_dir
\tmaitm6\logs directory

• UNIX:
hostname_ud00_instance_
name_
kud00agent_
HEXtimestamp-nn.log in the
install_dir/logs directory

These logs are in the following
directories:

• Windows: install_dir
\tmaitm6\logs

• UNIX: install_dir/logs

Traces activity of the monitoring
agent.

On the computer that hosts the
monitoring agent

The agent operations log files are
as follows:

instance_hostname_
UD00.LG0 is the current log
created when the agent is
started.

instance_hostname_
UD00.LG1 is the backup of the
previous log.

These logs are in the following
directory depending on the
operating system that you are
using:

• Windows: install_dir
\tmaitm6\logs

• UNIX: install_dir/logs

Shows whether the agent could
connect to the monitoring server.
Shows which situations are
started and stopped, and shows
other events while the agent is
running. A new version of this file
is generated every time the agent
is restarted.

IBM Tivoli Monitoring generates
one backup copy of the *.LG0
file with the tag .LG1. View
the .LG1 tag to learn the
following details regarding the
previous monitoring session:

• Status of connectivity with the
monitoring server

• Situations that were running
• The success or failure status of

Take Action commands
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Table 2. Trace log files for troubleshooting agents (continued)

System where log is located File name and path Description

Definitions of variables:

• timestamp is a time stamp with a format that includes year (y), month (m), day (d), hour (h), and
minute (m), as follows: yyyymmdd hhmm

• HEXtimestamp is a hexadecimal representation of the time at which the process was started.
• install_dir represents the directory path where you installed the IBM Tivoli Monitoring component.

install_dir can represent a path on the computer that hosts the monitoring system, the monitoring
agent, or the portal.

• instance refers to the name of the database instance that you are monitoring.
• instance_name refers to the name of the agent instance.
• hostname refers to the name of the computer on which the IBM Tivoli Monitoringcomponent runs.
• nn represents the circular sequence in which logs are rotated. this value includes a range from 1 - 5,

by default. The first is always retained because it includes configuration parameters.

For more information about the complete set of trace logs that are maintained on the monitoring server,
see the IBM Tivoli Monitoring Installation and Setup Guide.

Examples: using trace logs
Typically IBM Software Support applies specialized knowledge to analyze trace logs to determine the
source of problems. However, you can open trace logs in a text editor to learn some basic facts about
your IBM Tivoli Monitoring environment.
Example one

This excerpt shows the typical .LG0 log for a failed connection between a monitoring agent and a
monitoring server with the host name server1a:

(Thursday, August 11, 2005, 08:21:30-{94C}kdcl0cl.c,105,"KDCL0_ClientLookup") status=1c020006,
    "location server unavailable", ncs/KDC1_STC_SERVER_UNAVAILABLE
(Thursday, August 11, 2005, 08:21:35-{94C}kraarreg.cpp,1157,"LookupProxy") Unable to connect to
    broker at ip.pipe:: status=0, "success", ncs/KDC1_STC_OK
(Thursday, August 11, 2005, 08:21:35-{94C}kraarreg.cpp,1402,"FindProxyUsingLocalLookup") Unable
    to find running CMS on CT_CMSLIST <IP.PIPE:#server1a>

Example two
The following excerpts from the trace log for the monitoring server show the status of an agent,
identified here as "Remote node." The name of the computer where the agent is running is
SERVER5B:

(42C039F9.0000-6A4:kpxreqhb.cpp,649,"HeartbeatInserter") Remote node SERVER5B:KUD is ON-LINE.
. . .
(42C3079B.0000-6A4:kpxreqhb.cpp,644,"HeartbeatInserter") Remote node SERVER5B:KUD is OFF-LINE.

Key points regarding the preceding excerpt:

• The monitoring server appends the KUD product code to the server name to form a unique name
(SERVER5B:KUD) for this instance of DB2 agent. This unique name enables you to distinguish
multiple monitoring products that might be running on SERVER5B.

• The log shows when the agent started (ON-LINE) and later stopped (OFF-LINE) in the environment.
• For the sake of brevity an ellipsis (...) represents the series of trace log entries that were generated

while the agent was running.
• Between the ON-LINE and OFF-LINE log entries, the agent was communicating with the monitoring

server.
• The ON-LINE and OFF-LINE log entries are always available in the trace log. All trace levels that are

described in “RAS trace parameters” on page 8 provide these entries.
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On Windows systems, you can use the following alternate method to view trace logs:

1. To play the Manage Tivoli Enterprise Monitoring Services window, click Start > Programs > IBM Tivoli
Monitoring > Manage Tivoli Monitoring Services.

2. Right-click a component, and select Advanced > View Trace Log. The program displays the Select Log
File window that lists the RAS1 logs for the DB2 agent.

3. Select a log file from the list and click OK. You can also use this viewer to access remote logs.

Important: The viewer converts time stamps in the logs to a readable format.

RAS trace parameters
Pinpoint a problem by setting detailed tracing of individual components of the monitoring agent and
modules

See “Overview of log file management” on page 3 to ensure that you understand log rolling and can
reference the correct log files when you manage log file generation.

Setting RAS trace parameters by using the GUI
On Windows systems, you can use the graphical user interface to set trace options.

About this task
The IBM Tivoli Composite Application Manager Agent for DB2 uses RAS1 tracing and generates the logs
described in Table 2 on page 4. The default RAS1 trace level is ERROR.

Procedure

1. Open the Manage Tivoli Enterprise Monitoring Services window.
2. Select Advanced > Edit Trace Parms. The Tivoli Enterprise Monitoring Server Trace Parameters

window is displayed.
3. Select a new trace setting in the pull-down menu in the Enter RAS1 Filters field or type a valid string.

• General error tracing. KBB_RAS1=ERROR
• Intensive error tracing. KBB_RAS1=ERROR (UNIT:kud ALL)
• Maximum error tracing. KBB_RAS1=ERROR (UNIT:kud ALL) (UNIT:kra ALL)

Note: As this example shows, you can set multiple RAS tracing options in a single statement.
4. Modify the value for Maximum Log Size Per File (MB) to change the log file size (changes LIMIT value).
5. Modify the value for Maximum Number of Log Files Per Session to change the number of log files per

startup of a program (changes COUNT value).
6. Modify the value for Maximum Number of Log Files Total to change the number of log files for all

startups of a program (changes MAXFILES value).
7. Optional: Click Y (Yes) in the KDC_DEBUG Setting menu to log information that can help you diagnose

communications and connectivity problems between the monitoring agent and the monitoring server.
The KDC_DEBUG setting and the Maximum error tracing setting can generate a large amount of
trace logging. Use these settings only temporarily, while you are troubleshooting problems. Otherwise,
the logs can occupy excessive amounts of hard disk space.

8. Click OK. You see a message reporting a restart of the monitoring agent so that your changes take
effect.

What to do next

Monitor the size of the logs directory. Default behavior can generate a total of 45 - 60 MB for each agent
that is running on a computer. For example, each database instance that you monitor can generate 45 -
60 MB of log data. See the "Procedure" section to learn how to adjust file size and numbers of log files to
prevent logging activity from occupying too much disk space.
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Regularly prune log files other than the RAS1 log files in the logs directory. Unlike the RAS1 log files that
are pruned automatically, other log types can grow indefinitely, for example, the logs in Table 2 on page 4
that include a process ID number (PID).

Use collector trace logs as an additional source of troubleshooting information.

Note: The KDC_DEBUG setting and the Maximum error tracing setting can generate a large amount of
trace logging. Use these settings only temporarily while you are troubleshooting problems. Otherwise, the
logs can occupy excessive amounts of hard disk space.

Manually setting RAS trace parameters
You can manually edit the RAS1 trace logging parameters.

About this task
Agents use RAS1 tracing and generate the logs described in Table 2 on page 4. The default RAS1 trace
level is ERROR.

Procedure

1. Open the trace options file:

• Windows systems:

install_dir\tmaitm6\KUDENV_instance name
• UNIX systems:

install_dir /config/ud_instance name.config
2. Edit the line that begins with KBB_RAS1= to set trace logging preferences. For example, if you want

detailed trace logging, set the Maximum Tracing option: KBB_RAS1=ERROR (UNIT:kud ALL)
(UNIT:kra ALL)

3. Edit the line that begins with KBB_RAS1_LOG= to manage the generation of log files:

• MAXFILES: The total number of files that are to be kept for all startups of a specific program. When
this value is exceeded, the oldest log files are discarded. The default value is 9.

• LIMIT: The maximum size, in megabytes (MB) of a RAS1 log file. The default value is 5.
• IBM Software Support might guide you to modify the following parameters:

– COUNT: The number of log files to keep in the rolling cycle of one program startup. The default is 3.
– PRESERVE: The number of files that are not to be reused in the rolling cycle of one program

startup. The default value is 1.

Note: The KBB_RAS1_LOG parameter also provides for the specification of the log file directory, log
file name, and the inventory control file directory and name. Do not modify these values or log
information can be lost.

4. Restart the monitoring agent so that your changes take effect.

What to do next

Monitor the size of the logs directory. Default behavior can generate a total of 45 - 60 MB for each agent
that is running on a computer. For example, each database instance that you monitor can generate 45 -
60 MB of log data. See the "Procedure" section to learn how to adjust file size and numbers of log files to
prevent logging activity from occupying too much disk space.

Regularly prune log files other than the RAS1 log files in the logs directory. Unlike the RAS1 log files that
are pruned automatically, other log types can grow indefinitely, for example, the logs in Table 2 on page 4
that include a process ID number (PID).

Use collector trace logs as an additional source of troubleshooting information.
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Note: The KDC_DEBUG setting and the Maximum error tracing setting can generate a large amount of
trace logging. Use these settings only temporarily while you are troubleshooting problems. Otherwise, the
logs can occupy excessive amounts of hard disk space.

Dynamic modification of trace settings
You can dynamically modify the trace settings for an IBM Tivoli Monitoring component, such as, Tivoli
Enterprise Monitoring Server, Tivoli Enterprise Portal Server, most monitoring agents, and other
components. You can access these components, except for a few monitoring agents, from the tracing
utility.

Dynamic modification of the trace settings is the most efficient method, because you can do it without
restarting the component. Settings take effect immediately. Modifications by this method are not
persistent.

Note: When the component is restarted, the trace settings are read again from the .env file. Dynamically
modifying these settings does not change the settings in the .env files. To modify these trace settings
permanently, modify them in the .env files.

ras1

Run this command to modify the trace settings for a Tivoli Monitoring component.

The syntax is as follows:

ras1 set|list (UNIT|COMP: class_name ANY|ALL|Detail|ERROR|Flow|INPUT|Metrics|OUTPUT|STATE) 
{(UNIT|COMP: class_name ANY|ALL|Detail|ERROR|Flow|INPUT|Metrics|OUTPUT|STATE)}

You can specify more than one component class to which to apply the trace settings.

Command options
set

Turns on or off tracing depending upon the value of its parameters. If the parameter is ANY, it turns it
off. All other parameters turn on tracing based on the specified type or level.

list
Displays the default level and type of tracing that is set by default.

Parameters

The parameters that determine the component classes to which to apply the trace settings are as follows:
COMP: class_name

Modifies the trace setting for the name of the component class, as specified by class_name , for
example, COMP:KDH. The output contains trace for the specified class.

UNIT: class_name
Modifies the trace setting for any unit that starts with the specified class_name value, for example,
UNIT: kra. The output contains trace for any unit that begins with the specified filter pattern.

The parameters that determine the trace level and type are as follows:
ALL

Displays all trace levels, including every trace point defined for the component. This setting might
result in a large amount of trace, so specify other parameters to exclude unwanted trace. You might
require the ALL parameter to isolate a problem, which is the equivalent to setting "Error Detail
Flow State Input Output Metrics".

ANY
Turns off tracing.

Detail
Displays detailed information about each function.

When entered with the list option, the trace is tagged with Det.
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ERROR
Logs internal error conditions.

When entered with the list option, the trace is tagged with ER. The output can also be tagged with
EVERYE+EVERYU+ER.

Flow
Displays control flow data for each function entry and exit.

When entered with the list option, the trace is tagged with Fl.

INPUT
Displays input data for each function.

When entered with the list option, the trace is tagged with IN.

Metrics
Displays metrics on each function.

When entered with the list option, the trace is tagged with ME.

OUTPUT
Displays output data for each function.

When entered with the list option, the trace is tagged with OUT.

State
Displays the status for each function.

When entered with the list option, the trace is tagged with St.

Example
If you enter ras1 set (COMP:KDH ALL) (COMP:ACF1 ALL) (COMP:KDE ALL), the trace utility
turns on all levels of tracing for all the files and functions for which KDH, ACF1, and KDE are the classes.

kbbcre1.c, 400, May 29 2007, 12:54:43, 1.1, * 
kbbcrn1.c, 400, May 29 2007, 12:54:42, 1.1, * 
kdhb1de.c, 400, May 29 2007, 12:59:34, 1.1, KDH 
kdh0med.c, 400, May 29 2007, 12:59:24, 1.1, KDH 
kdhsrej.c, 400, May 29 2007, 13:00:06, 1.5, KDH 
kdhb1fh.c, 400, May 29 2007, 12:59:33, 1.1, KDH 
kdhb1oe.c, 400, May 29 2007, 12:59:38, 1.2, KDH
kdhs1ns.c, 400, May 29 2007, 13:00:08, 1.3, KDH
kbbacdl.c, 400, May 29 2007, 12:54:27, 1.2, ACF1
kbbaclc.c, 400, May 29 2007, 12:54:27, 1.4, ACF1 
kbbac1i.c, 400, May 29 2007, 12:54:28, 1.11, ACF1 
vkdhsfcn.c, 400, May 29 2007, 13:00:11, 1.1, KDH 
kdhserq.c, 400, May 29 2007, 12:59:53, 1.1, KDH 
kdhb1pr.c, 400, May 29 2007, 12:59:39, 1.1, KDH
kdhsgnh.c, 400, May 29 2007, 12:59:49, 1.1, KDH
kdh0uts.c, 400, May 29 2007, 12:59:23, 1.1, KDH
kdhsrsp.c, 400, May 29 2007, 13:00:13, 1.2, KDH
kdhs1rp.c, 400, May 29 2007, 13:00:12, 1.1, KDH
kdhscsv.c, 400, May 29 2007, 12:59:58, 1.9, KDH
kdebbac.c, 400, May 29 2007, 12:56:50, 1.10, KDE 
...

Turning on tracing
To use the tracing utility, you must use a local logon credential for the computer. This tracing method
uses the IBM Tivoli Monitoring Service Console. Access the Service Console by using a web browser.

About this task
When you start the Service Console, information is displayed about the components that are currently
running on that computer. For example, these components are listed as follows:

• Tivoli Enterprise Portal Server: cnp
• Monitoring Agent for Windows OS: nt
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• Tivoli Enterprise Monitoring Server: ms

After you log on, you can type a question mark (?) to display a list of the supported commands. Use the
ras1 command to modify trace settings. If you type this command in the field provided in the Service
Console window and click Submit, the help for this command is displayed.

Procedure

1. Open a web browser and enter the URL to access the Service Console.

http://hostname:1920

where hostname is the IP address or host name of the computer on which the IBM Tivoli Monitoring
component is running.

2. Click the hyperlink associated with the component for which you want to modify its trace settings.

Note: In the previous view, if you want to modify tracing for the Tivoli Enterprise Monitoring Server,
select IBM Tivoli Monitoring Service Console under Service Point: system.your host name_ms.

3. Enter a user ID and password to access the system. This ID is any valid user that has access to the
system.

4. Enter the command to turn on the required level of trace for the specified component classes or units.

ras1 set (UNIT|COMP: class_name ALL|Flow|ERROR|Detail|INPUT|Metrics|OUTPUT|STATE) 
{(UNIT|COMP: class_name ALL|Flow|ERROR|Detail|INPUT|Metrics|OUTPUT|STATE)}

For example, to turn on the control flow trace for the KDE, the command is:

ras1 (COMP:KDE Flow)

Turning off tracing
You can use the IBM Tivoli Monitoring Service Console to run the ras1 command and dynamically turn off
tracing.

Procedure

1. Open a web browser and enter the URL to access the Service Console.

http://hostname:1920

where hostname is the IP address or host name of the computer on which the IBM Tivoli Monitoring
component is running.

2. Click the hyperlink associated with the component for which you want to modify its trace settings.

3. Enter a user ID and password to access the system. This ID is any valid user that has access to the
system.

4. Enter the command to turn off the required level of trace for the specified component classes or units.

ras1 set (UNIT|COMP: class_name ANY) 
{(UNIT|COMP: class_name ANY)}

For example, to turn off tracing for the kbbcrcd class of the Windows OS agent, the command is:

ras1 set (UNIT:kbbcrcd ANY)
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Setting trace parameters for the Tivoli Enterprise Console server
In addition to the trace information captured by IBM Tivoli Monitoring, you can also collect additional
trace information for the Tivoli Enterprise Console® components that gather event server metrics.

About this task
To collect this information, modify the .tec_diag_config file on the Tivoli Enterprise Console event
server. Use the steps in the following procedure to modify the event server trace parameters.

Procedure

1. Open the $BINDIR/TME/TEC/.tec_diag_config file in an ASCII editor.
2. Locate the entries that configure trace logging for the agent components on the event server. Two

entries are included, one for tec_reception and one for tec_rule:

# to debug Agent Utils 
tec_reception Agent_Utils  error   /tmp/tec_reception 
SP
# to debug Agent Utils 
tec_rule Agent_Utils   error   /tmp/tec_rule 

3. To gather additional trace information, modify these entries to specify a trace level of trace2:

# to debug Agent Utils 
tec_reception Agent_Utils   trace2  /tmp/tec_reception 
SP
# to debug Agent Utils 
tec_rule Agent_Utils       trace2  /tmp/tec_rule 

4. In addition, modify the Highest_level entries for tec_rule and tec_reception:

tec_reception Highest_level  trace2 
SP
tec_rule Highest_level trace2 
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Chapter 3. Problems and workarounds
The known problems and workarounds are organized into types of problems that might occur with an
agent, for example installation and configuration problems and workspace problems.

You can resolve some problems by ensuring that your system matches system requirements. The most
up-to-date requirements are in the Software product compatibility reports (http://
publib.boulder.ibm.com/infocenter/prodguid/v1r0/clarity/index.html).

For general troubleshooting information, see the IBM Tivoli Monitoring Troubleshooting Guide.

Installation and configuration troubleshooting
This section provides tables that show solutions for the following types of installation, configuration, and
uninstallation problems:

• Operating system problems
• Problems with database applications

Table 3. Problems and solutions for installation and configuration for agents that run on UNIX and Linux systems

Problem Solution

After installing IBM Tivoli Monitoring
6.2.3 fix pack 1 and then installing the
DB2 agent you attempt to run the
following command

./cinfo -t ud

This results in an error message
containing the following line:

grep: can't open jraix523.ver

There is currently no solution to this problem at this time.

When you upgrade to IBM Tivoli
Monitoring, you might need to apply fix
packs to Candle, Version 350, agents.

Fix packs for Candle, Version 350, are delivered as each monitoring
agent is upgraded to IBM Tivoli Monitoring.

Important: The IBM Tivoli Monitoring download image or CD provides
application fix packs for the monitoring agents that are installed from
that CD (for example, the agents for operating systems such as
Windows, Linux, UNIX, and i5/OS). The upgrade software for other
agents is located on the download image or CDs for that specific
monitoring agent, such as the agents for database applications.

If you do not upgrade the monitoring agent to IBM Tivoli Monitoring,
the agent continues to work. However, you must upgrade to have all
the functionality that IBM Tivoli Monitoring offers.

Presentation files and customized
OMEGAMON® DE screens for Candle
monitoring agents need to be
upgraded to a new Linux on z/Series
system.

The upgrade from version 350 to IBM Tivoli Monitoring handles export
of the presentation files and the customized OMEGAMON DE screens.
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Table 3. Problems and solutions for installation and configuration for agents that run on UNIX and Linux systems
(continued)

Problem Solution

The following message is displayed in
the installation log for some Windows
agents when upgrading from Tivoli
OMEGAMON V350: <REPLACELINE>
Pair missing
1=[KBB_RAS1=ERROR] no 2,
skipped.

There is no workaround. The previous value of KBB_RAS1 from the
OMEGAMON V350 agent is used, preserving prior customer settings
for this variable. The problem has no adverse effect on the installation
or subsequent operation of the monitoring agent .

Non-ASCII characters entered into the
configuration window for the
monitoring agent do not show up or
are not the correct characters.

Enter only ASCII characters into these fields.

During the command-line installation,
you choose to install a component that
is already installed, and you see the
following warning:

WARNING - you are about to install
the SAME version of "component" 

where component is the name of the
component that you are attempting to
install.

Important: This problem affects UNIX
and Linux command-line installations.
If you monitor only Windows
environments, you see this problem if
you choose to install a product
component (for example, a monitoring
server) on a UNIX or Linux system.

You must exit and restart the installation process. You cannot return
to the list where you selected components to install. When you run
the installer again, do not attempt to install any component that is
already installed.

While installing the agent from a CD,
the following message is displayed and
you are not able to continue the
installation:

install.sh warning: unarchive of
"/cdrom/unix/cienv1.tar" may 
have failed

This error is caused by low disk space. Although the install.sh script
indicates that it is ready to install the agent software, the script
considers the size of all tar files, not the size of all the files that are
contained within the tar file.

Run the df -k command to check whether the file systems have
enough space to install agents.
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Table 3. Problems and solutions for installation and configuration for agents that run on UNIX and Linux systems
(continued)

Problem Solution

You see an error similar to the
following example:

db2inst3@aix7%> ./bin/itmcmd
agent -o db2inst3 start ud
CandleAgent : installer level
400 / 100. find: 0652-023
Cannot open file /home/ITM/
images. find: 0652-023 Cannot
open file /home/ITM/images.
find: 0652-023 Cannot open
file /home/ITM/images. find:
0652-023 Cannot open file /
home/ITM/images.
CandleAgent : running aix513
jre. Starting agent... Agent
Started... db2inst3@aix7%>

When the product has been installed using the root user account, you
can change from the root user account to a different user account
without re-installing the product.

Use the CHMOD command to update the privileges for specific
directories in the installation path for IBM Tivoli Monitoring. For
example, you might use the root user account to install the DB2 agent
and attempt to run the agent as the DB2 instance owner.

Important: The error (in the "Problem" column) is occurring only for
the images directory. The DB2 agent runs correctly, in spite of the
error message. To avoid getting the Cannot open file...
message, run the chmod -R 755 directory command, where
directory is the directory specified in the error.

Cannot locate the KDCB0_HOSTNAME
setting.

Go to install_dir/config and edit the corresponding .ini file. Set
the KDCB0_HOSTNAME parameter followed by the IP address. If you
use multiple network interface cards (NICs), give the Primary IP
address of the network interface.

The DB2 agent repeatedly restarts. You can collect data to analyze this problem as follows:

1. Access the install_dir/config/ud.ini file, which is
described in “RAS trace parameters” on page 8.

2. Add the following line: KBB_SIG1=trace –dumpoff

Agents in the monitoring environment
use different communication
protocols. For example, some agents
have security enabled and others do
not.

Configure both the monitoring server and the Warehouse Proxy server
to accept multiple protocols, as described in the IBM Tivoli Monitoring
Installation and Setup Guide.

Creating a firewall partition file: The
partition file enables an agent to
connect to the monitoring server
through a firewall.

How it works: When the agents start, they search
KDCPARTITION.TXT for the following matches:

• An entry that matches the partition name OUTSIDE
• An entry that also includes a valid external address.

For more information, see the IBM Tivoli Monitoring Installation and
Setup Guide.

You see the following error:

Hub not registered with location 
broker. Error-code 1195.

Confirm that the password within the Tivoli Enterprise Monitoring
Server is correct.

The DB2 agent is started and running
but not displaying data in the Tivoli
Enterprise Portal.

Confirm that application support for this monitoring agent has been
added to the Tivoli Enterprise Monitoring Server, and confirm that you
have configured the Tivoli Enterprise Portal Server as described in the
IBM Tivoli Monitoring Installation and Setup Guide. Also, see Exploring
IBM Tivoli Monitoring to learn about overall installation and
configuration issues.
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Table 3. Problems and solutions for installation and configuration for agents that run on UNIX and Linux systems
(continued)

Problem Solution

You successfully upgraded from an
OMEGAMON monitoring agent to IBM
Tivoli Monitoring, Version 6.2.0.
However, when you configure
historical data collection, you see an
error message that includes,
Attribute name may be
invalid, or attribute file
not installed for warehouse
agent.

Copy the attribute files (kud.atr) for the upgraded monitoring agent to
the install_dir/tables/TEMS_name/ATTRLIB directory on the
computer where you have installed the Warehouse Proxy agent. The
Warehouse Proxy agent must be able to access the short attribute
names for tables and columns. That way, if the longer versions of
these names exceed the limits of the Warehouse database, the
shorter names can be substituted.

The DB2 agent does not start in a non-
ASCII environment.

Check the agent configuration to ensure that all the values are
correctly represented. To view these parameters, go to the Manage
Tivoli Enterprise Monitoring Services window, select the agent
template, and choose the Configure using defaults. From the resulting
window, select and edit the database instance to view its parameters.

Text for configuration functions is
displayed in English instead of native
languages when installing and
configuring the DB2 agent. For
example, when using the itmcmd
config command on a UNIX or Linux
system.

None. You must complete configuration of the DB2 agent using
English.

The system is experiencing high CPU
usage.

Agent process: View the CPU usage of the kuddb2 process on a UNIX
or Linux system. If CPU usage seems to be excessive, recycle the DB2
agent.

Network Cards: The network card configurations can decrease the
performance of a system. Each of the stream of packets that a
network card receives (assuming it is a broadcast or destined for the
under-performing system) must generate a CPU interrupt and transfer
the data through the I/O bus. If the network card in question is a bus-
mastering card, work can be off-loaded and a data transfer between
memory and the network card can continue without using CPU
processing power. Bus-mastering cards are generally 32-bit and are
based on PCI or EISA bus architectures.

You successfully upgraded from an
earlier version of IBM Tivoli Composite
Application Manager Agent for DB2 to
IBM Tivoli Composite Application
Manager Agent for DB2 , Version 6.2.2.
However, in the History Collection
Configuration window, the names of
the attribute groups that you enabled
historical data collection with the
earlier version changed to the
following format: KUD00_tablename.

Move your mouse to the name of an attribute group, and the fly-over
text displays the attribute group name. You can rename these
attribute groups using the Name field.
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Table 3. Problems and solutions for installation and configuration for agents that run on UNIX and Linux systems
(continued)

Problem Solution

Installation of DB2 agent 7.1.1 fails on
HP-UX operating system as
"06.16.30.000" JR component is not
found.

Complete the following steps to resolve this issue:

1. To revert the JRE version to an older one, replace the following line
in jrhpi116.dsc file:

<Command>|DEPOTDIR|/ci/DeployLnk.sh |DEPOTDIR| jr
hpi116 070950000 </Command>

with

<Command>|DEPOTDIR|/ci/DeployLnk.sh |DEPOTDIR| jr
hpi116 061630000 </Command>

2. Replace the following line in jrhpi116.ver file:

# Release level.
ver = 709
rel = 100
# Alternate Directory for Agent Version Parity
altDir=tmaitm6
VRMF = 07095000

with

# Release level.
ver = 616
rel = 100
# Alternate Directory for Agent Version Parity
altDir=tmaitm6
VRMF = 06163000

Table 4. Problems and solutions for installation and configuration on Windows

Problem Solution

When you upgrade to IBM Tivoli
Monitoring, you might need to
apply fix packs to Candle,
Version 350, agents.

Fix packs for Candle, Version 350, are delivered as each monitoring agent is
upgraded to IBM Tivoli Monitoring.

Important: The IBM Tivoli Monitoring download image or CD provides
application fix packs for the monitoring agents that are installed from that CD
(for example, the agents for operating systems such as Windows, Linux,
UNIX, and i5/OS). The upgrade software for other agents is located on the
download image or CDs for that specific monitoring agent, such as the agents
for database applications.

If you do not upgrade the monitoring agent to IBM Tivoli Monitoring, the
agent continues to work. However, you must upgrade to have all the
functionality that IBM Tivoli Monitoring offers.

Presentation files and
customized OMEGAMON DE
screens for Candle monitoring
agents need to be upgraded to
a new Linux on z/Series system.

The upgrade from version 350 to IBM Tivoli Monitoring handles export of the
presentation files and the customized OMEGAMON DE screens.
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Table 4. Problems and solutions for installation and configuration on Windows (continued)

Problem Solution

Diagnosing problems with
product browse settings.

When you have problems with browse settings, perform the following steps:

1. Click on Start > Programs > IBM Tivoli Monitoring > Manage Tivoli
Monitoring Services. The Manage Tivoli Enterprise Monitoring Services
window is displayed.

2. Right-click the Windows agent and select Browse Settings. A text window
is displayed.

3. Click Save As and save the information in the text file. If requested, you
can forward this file to IBM Software Support for analysis.

A message similar to "Unable to
find running CMS on
CT_CMSLIST" in the log file is
displayed.

If a message similar to "Unable to find running CMS on CT_CMSLIST" is
displayed in the Log file, the agent is not able to connect to the monitoring
server. Confirm the following points:

• Is the computer that hosts the monitoring server running and connected to
the network?

• Do multiple network interface cards (NICs) exist on the system?
• If multiple NICs exist on the system, find out which one is configured for

the monitoring server. Ensure that you specify the correct host name and
port settings for communication in the IBM Tivoli Monitoring environment.

The system is experiencing
high CPU usage.

Agent process: View the CPU usage of the KUDCMA process on Windows
systems. If CPU usage seems to be excessive, recycle the DB2 agent.

Network Cards: The network card configurations can decrease the
performance of a system. Each of the stream of packets that a network card
receives (assuming it is a broadcast or destined for the under-performing
system) must generate a CPU interrupt and transfer the data through the I/O
bus. If the network card in question is a bus-mastering card, work can be off-
loaded and a data transfer between memory and the network card can
continue without using CPU processing power. Bus-mastering cards are
generally 32-bit and are based on PCI or EISA bus architectures.

Text for configuration functions
is displayed in English instead
of native languages when
installing and configuring the
DB2 agent. For example, when
using the Manage Tivoli
Enterprise Monitoring Services
GUI on a Windows system.

None. You must complete configuration of the DB2 agent using English.

You successfully upgraded
from an OMEGAMON
monitoring agent to IBM Tivoli
Monitoring, Version 6.2.0.
However, when you configure
historical data collection, you
see an error message that
includes, Attribute name
may be invalid, or
attribute file not
installed for warehouse
agent

Copy the attribute files (kud.atr) for the upgraded monitoring agent to
install_dir\tmaitm6\attrlib on the computer where you have
installed the Warehouse Proxy agent. The Warehouse Proxy agent must be
able to access the short attribute names for tables and columns. That way, if
the longer versions of these names exceed the limits of the Warehouse
database, the shorter names can be substituted.
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Table 4. Problems and solutions for installation and configuration on Windows (continued)

Problem Solution

You successfully upgraded
from an earlier version of Tivoli
Composite Application Manager
Agent for DB2 to Tivoli
Composite Application Manager
Agent for DB2 , Version 6.2.2.
However, in the History
Collection Configuration
window, the names of the
attribute groups that you
enabled historical data
collection with the earlier
version changed to the
following format:
KUD00_tablename.

Move your mouse to the name of an attribute group, and the fly-over text
displays the attribute group name. You can rename these attribute groups
using the Name field.
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Table 4. Problems and solutions for installation and configuration on Windows (continued)

Problem Solution

When the DB2 agent is installed
using group deployment, DB2
deploygroup was run multiple
times. The group deployment
starts and completes
successfully, but there were
multiple entries in the Deploy
Status Summary workspace on
the Tivoli Enterprise Portal.
When the command tried to
install multiple times, the
additional installations were
queued and then were in failed
state though the agent was
deployed successfully.

Note:

• When the bundle group
contains a single bundle and
the deploy group contains
more than one member
(managed system of the
same type as AIX or Linux),
the deployment is successful
on both systems.

• When the bundle group
contains more than one
bundle and the deploy group
contains single or multiple
members, the deployment
will be executed on each
group member (managed
system) depending on the
members present in the
bundle group and deploy
group.

• The command creates a
transaction for each XX
bundle for each target
system; the bundle matching
the operating system for the
deployment member is
processed successfully; and
remaining transactions were
in a queued or failed state

There is no solution at this time.

The following table shows problems and solutions for the DB2 agent.
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Table 5. Problems and solutions for installation and configuration of the DB2 agent

Problem Solution

ITM6.2.3 adds a new
functionality for Automatic
Agent support files Data
Synchronization called Self
Describing Agent (SDA). This
automatic product support
installation feature helps to
eliminate errors that might
occur from the inconsistent
installation of application data
on the IBM Tivoli Monitoring
server. It also avoids the need
to recycle the hub Tivoli
Enterprise Monitoring Server,
Tivoli Enterprise Portal Server,
or remote Tivoli Enterprise
Monitoring Server to perform a
product installation. However
when SDA is enabled certain
situations available with the
DB2 agent are no longer
displayed and the DB2 node in
the History Collection
configuration is also no longer
displayed.

Restart the Tivoli Enterprise Portal Server.

The installation of the self-
describing agent feature fails
when the DB2 agent V7.1 is
installed alone.

Upgrade the following components that support SDA to V6.2.3: ax (IBM Tivoli
Monitoring Shared Libraries), ue (Tivoli Enterprise Services User Interface
Extensions), and ui (Tivoli Enterprise Services User Interface).

The procedure for launching
the DB2 agent: Trace
Parameters window in Setting
RAS trace parameters fails.

This problem occurs when the trace options are missing from the
configuration file. You can correct the problem by doing the following steps:

1. Edit a text file with the following path name:

• On Windows systems: install_dir\tmaitm6\logs\KUDRAS1
• On UNIX and Linux systems: /install_dir/config/ud.ini

2. Paste the following configuration setting in the file:

• On Windows systems:

KBB_RAS1=ERROR ^> C:\IBM\ITM\tmaitm6\logs\KUDRAS1.LOG 

Remember: If you installed the product in a directory path other than
the default, use that directory path instead of C:\IBM\ITM.

• On UNIX and Linux systems:

KBB_RAS1=ERROR

The default installation path on UNIX is /opt/IBM/ITM.
3. Save your changes.
4. Repeat the “RAS trace parameters” on page 8 procedure. Now the Tivoli

Enterprise Monitoring Server: Trace Parameters window is displayed.
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Table 5. Problems and solutions for installation and configuration of the DB2 agent (continued)

Problem Solution

After running the agent
successfully, you reinstall the
agent software, and collection
of monitoring data stops.

See the list of supported versions in the Installation and Configuration Guide
for the agent. Confirm that you are running a valid version of the target
application. If you are monitoring a supported version of the database
application, gather log files and other information and contact IBM Software
Support, as described in Table 1 on page 1.

Error counts are displayed in
the Alert summary report in the
Tivoli Enterprise Portal,
however, error messages are
not displayed in the Alert detail
report.

Check the time stamp for the reports. If you have set up historical data
collection for Alert summary report, set up historical data collection for the
Alert detail report, too.

An error window is displayed
with the message "Service
executable not found.
Cannot configure
service."

This problem occurs when non-ASCII characters are entered for the DB2
instance name. Delete the configured Tivoli Enterprise Monitoring Server
instance and recreate an instance specifying an instance name with ASCII
characters only.

After you add the agent bundle
to the Tivoli Enterprise
Monitoring Server, if the IBM
Tivoli Composite Application
Manager Agent for DB2 is still
not listed in the Select a
Monitoring Agent window.

Deploy the agent through the command line.

Table 6. General problems and solutions for uninstallation

Problem Solution

On Windows systems,
uninstallation of IBM Tivoli
Monitoring fails to uninstall the
entire environment.

Confirm that the following problems do not exist:

• Ensure that you are the only user who is logging into the computer where
you are performing an uninstallation operation. If another user is
performing operations during an uninstall process, the uninstall process
fails.

• Be sure that you follow the general uninstallation process described in the
IBM Tivoli Monitoring Installation and Setup Guide:

1. Uninstall monitoring agents first, as in the following examples:

– Uninstall a single monitoring agent for a specific database.

—OR—
– Uninstall all instances of a monitoring product, such as IBM Tivoli

Monitoring for Databases.
2. Uninstall IBM Tivoli Monitoring.
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Table 6. General problems and solutions for uninstallation (continued)

Problem Solution

The way to remove inactive
managed systems (systems
whose status is OFFLINE) from
the Navigator tree in the portal
is not obvious.

Use the following steps to remove, but not uninstall, an offline managed
system from the Navigator tree:

1. Click the Enterprise icon in the Navigator tree.
2. Right-click, and click Workspace > Managed System Status.
3. Right-click the offline managed system, and select Clear offline entry.

If you also want to uninstall the DB2 agent, use the procedure described in
the IBM Tivoli Monitoring Installation and Setup Guide.

There is no configuration
command or menu option to
remove an instance of the DB2
agent that was created and
configured on a UNIX or Linux
system.

Use the following steps to delete an instance of the DB2 agent:

1. Stop the DB2 agent.
2. Open the install_dir directory.
3. Open the config directory.
4. Open the .ConfigData directory.
5. Edit the kudenv file, removing all lines beginning with INSTANCE.
6. Save the file, and exit.

The software inventory tag for
the agent on UNIX and Linux
systems is not removed during
uninstallation of the agent.

After uninstalling the agent, manually remove the file named full name of
agent.cmptag from the $CANDLEHOME/properties/version/ directory.

Unique names for monitoring components

About this task

IBM Tivoli Monitoring might not be able to generate a unique name for monitoring components because of
the truncation of names that the product automatically generates.

IBM Tivoli Monitoring automatically creates a name for each monitoring component by concatenating the
subsystem name, host name, and product code separated by colons (subsystem_name:hostname:UD).

Important: When you monitor a multinode system, such as a database, IBM Tivoli Monitoring adds a
subsystem name to the concatenated name, typically a database instance name.

The length of the name that IBM Tivoli Monitoring generates is limited to 32 characters. Truncation can
result in multiple components having the same 32-character name. If this problem happens, shorten the
hostname portion of the name as follows:

Procedure

1. Open the configuration file for the DB2 agent, which is located in the following path:

• On Windows systems: install_dir\tmaitm6\KUDCMA_instance.ini.
• On UNIX and Linux systems: 1.

2. Find the line that begins with CTIRA_HOSTNAME=.
3. Type a new name for host name that is a unique, shorter name for the host computer. The final

concatenated name including the subsystem name, new host name, and UD, cannot be longer than 32
characters.

1 install_dir/config/ud.ini
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Remember: You must ensure that the resulting name is unique with respect to any existing monitoring
component that was previously registered with the Tivoli Enterprise Monitoring Server.

4. Save the file.
5. Restart the agent.
6. If you do not find the files mentioned in Step 1, perform the workarounds listed in the next paragraph.

Results

If you do not find the files mentioned in the preceding steps, uninstall the DB2 agent, and install the DB2
agent again.

Agent troubleshooting
This section lists problems that might occur with agents.

This chapter provides agent-specific troubleshooting information. See the IBM Tivoli Monitoring
Troubleshooting Guide for general troubleshooting information.

Table 7. Agent problems and solutions for the DB2 agent

Problem Solution

Execution of deprecated situations
results in a "Problem" status.

The defined query formula is too long. You must split your query
formulae into smaller queries.

DB2 databases are visible in TADDM
but not visible in TBSM.

Remove the comments for the following section of the
CDM_TO_TBSM4x_MAP_Templates.xml file:

<--
<template primary='BSM_DB2Database' >
<othertemplate name='SCR_RetrieveDependentObjectsTemplate'/>
<othertemplate name='SCR_ServiceComponentRawStatusTemplate'/>
<othertemplate name='BSM_Database'/>
<othertemplate name='BSM_Application'/>
<cdmclass name='cdm:app.db.db2.Db2Database'/>
</template>
-->

Note: For version 6.1 of TBSM the following additional steps are
required to first export the file for editing and then to import it after you
are done removing the comments from the above section:

• To extract the file from the TBSM artifact store use the getArtifact
command

• To import the edited file back into the system use the putArtifact
command.

• To apply the changes use the utils.sh command.

You have completed all the
installation and configuration task
for the DB2 agent. You then start the
agent and find that some HADR
related attributes are not available.
For example attributes accessible
through the Database Table
workspace.

There is no solution to this problem at this time.

When you edit the configuration for
an existing monitoring agent, the
values displayed are not correct.

The original configuration settings might include non-ASCII characters.
These values were stored incorrectly and result in the incorrect display.
Enter new values using only ASCII characters.
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Table 7. Agent problems and solutions for the DB2 agent (continued)

Problem Solution

Column names have different
formats in table views for the DB2
agent.

Some attributes for the DB2 agent have length restrictions that cause
the short column name to be used if the modified column name
becomes too long.

A problem can arise when you run
multiple agents on one computer
and want them to communicate with
multiple monitoring servers, as
described in this example:

• Agents are running on a computer
and communicating with a Tivoli
Enterprise Monitoring Server,
called TEMS1.

• You install a new agent on the
same computer and you want this
agent to communicate with a
different monitoring server, called
TEMS2.

• When you configure the new agent
to communicate with TEMS2, all
the existing agents are re-
configured to communicate with
TEMS2.

You must reconfigure the previously existing agents to restore their
communication connection with TEMS1. For example, you can right-
click the row for a specific agent in the Manage Tivoli Enterprise
Monitoring Services, and select Reconfigure. See the IBM Tivoli
Monitoring Installation and Setup Guide for more information on
reconfiguration.

If you plan to install and run multiple instances of the DB2 agent on one
computer, these instances can use the same network interface, because
they run as different processes.

However, if you want to have two DB2 agent instances on the same
computer or want to run two instances of each agent, install two-
network adapters. Each instance is configured for the host-specific
address so they can be recognized in the configuration settings.

The DB2 agent is installed and
running normally. After rebooting
the computer where the Tivoli
Enterprise Monitoring Server was
running, or restarting the system
that hosts the Tivoli Enterprise
Monitoring Server, the agent is not
online. However, when you use
CandleAgent start, the agent
starts and continues running.

This problem can occur when the agent is installed locally using a non-
root user, or when the agent is installed remotely using the Run As
option on the GUI or using the _UNIX_STARTUP_.Username option on
the tacmd addSystem command line.

Verify whether you have used a non-root user to install the DB2 agent.

Manually start the DB2 agent using the correct user ID.

For more information, see "Upgrading and restarting the agent by using
non-root" in the Installation and Configuration Guide for the DB2 agent.

You receive the following error when
stopping the DB2 agent when
running with a local non-root UID on
a UNIX or Linux Server:

./itmcmd agent -o db2itm61
stop ud Stopping agent...
Unable to stop agent or
process... PID: 10642
attempt return code: 2

This message indicates that the UID that you are using does not have
the necessary operating system privileges to stop the DB2 agent.
Change to the UID that is running the DB2 agent, and run the stop
command again. Use the following command on the UNIX or Linux
Server:

install_dir/bin/cinfo -r

Use the UID that is returned as logged into the UNIX or Linux server to
stop the DB2 agent.

for more information, see "Permissions for starting and stopping the
DB2 agent on UNIX and Linux systems" in the Installation and
Configuration Guide for the agent.
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Table 7. Agent problems and solutions for the DB2 agent (continued)

Problem Solution

A configured and running instance of
the DB2 agent is not displayed in the
Tivoli Enterprise Portal, but other
instances of the DB2 agent on the
same system are displayed in the
portal.

Tivoli Monitoring products use Remote Procedure Call (RPC) to define
and control product behavior. RPC is the mechanism that allows a client
process to make a subroutine call (such as GetTimeOfDay or
ShutdownServer) to a server process somewhere in the network. Tivoli
processes can be configured to use TCP/UDP, TCP/IP, SNA, and SSL as
the desired protocol (or delivery mechanism) for RPCs.

"IP.PIPE" is the name given to Tivoli TCP/IP protocol for RPCs. The RPCs
are socket-based operations that use TCP/IP ports to form socket
addresses. IP.PIPE implements virtual sockets and multiplexes all
virtual socket traffic across a single physical TCP/IP port (visible from
the netstat command).

A Tivoli process derives the physical port for IP.PIPE communications
based on the configured, well-known port for the HUB Tivoli Enterprise
Monitoring Server. (This well-known port or BASE_PORT is configured
using the 'PORT:' keyword on the KDC_FAMILIES / KDE_TRANSPORT
environment variable and defaults to '1918'.)

The physical port allocation method is defined as (BASE_PORT +
4096*N) where N=0 for a Tivoli Enterprise Monitoring Server process
and N={1, 2, ..., 15} for a non-Tivoli Enterprise Monitoring Server. Two
architectural limits result as a consequence of the physical port
allocation method:

• No more than one Tivoli Enterprise Monitoring Server reporting to a
specific Tivoli Enterprise Monitoring Server HUB can be active on a
system image.

• No more that 15 IP.PIPE processes can be active on a single system
image.

A single system image can support any number of Tivoli Enterprise
Monitoring Server processes (address spaces) provided that each Tivoli
Enterprise Monitoring Server on that image reports to a different HUB.
By definition, there is one Tivoli Enterprise Monitoring Server HUB per
monitoring Enterprise, so this architecture limit has been simplified to
one Tivoli Enterprise Monitoring Server per system image.

No more that 15 IP.PIPE processes or address spaces can be active on a
single system image. With the first limit expressed above, this second
limitation refers specifically to Tivoli Enterprise Monitoring Agent
processes: no more that 15 agents per system image.

This limitation can be circumvented (at current maintenance levels, IBM
Tivoli Monitoring V6.1 Fix Pack 4 and later) if the Tivoli Enterprise
Monitoring Agent process is configured to use EPHEMERAL IP.PIPE.
(This is IP.PIPE configured with the 'EPHEMERAL:Y' keyword in the
KDC_FAMILIES / KDE_TRANSPORT environment variable). There is no
limitation to the number of ephemeral IP.PIPE connections per system
image. If ephemeral endpoints are used, the Warehouse Proxy Agent is
accessible from the Tivoli Enterprise Monitoring Server associated with
the agents using ephemeral connections either by running the
Warehouse Proxy Agent on the same computer or by using the Firewall
Gateway feature. (The Firewall Gateway feature relays the Warehouse
Proxy Agent connection from the Tivoli Enterprise Monitoring Server
computer to the Warehouse Proxy Agent computer if the Warehouse
Proxy Agent cannot coexist on the same computer.)
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Table 7. Agent problems and solutions for the DB2 agent (continued)

Problem Solution

Agent unable to connect: The agent
is started, but no reports are
displayed on Tivoli Enterprise
Monitoring Server. The log file
includes the following error:

Unable to find running CMS on 
CMSLIST or Endpoint 
unavailable

This error message means that the agent is not able to connect to the
computer where the Tivoli Enterprise Monitoring Server is running. The
reason might be any one of the following reasons:
Computer where the Tivoli Enterprise Monitoring Server is running is
down

Ping the computer where the Tivoli Enterprise Monitoring Server is
running and make sure that it is up and running.

Tivoli Enterprise Monitoring Server is not running
If the Tivoli Enterprise Monitoring Server is not running, recycle the
Tivoli Enterprise Monitoring Server and verify whether the agent is
connecting.

Multiple NIC Cards on the computer where the Tivoli Enterprise
Monitoring Server is running.

If multiple NICs are installed on the computer where the Tivoli
Enterprise Monitoring Server is running, identify the Primary NIC and
use the hostname or IP address.

Verify that the Tivoli Enterprise Monitoring Server has been
configured with the IP address or hostname of the Primary NIC.

If you are using hostname, make sure that /etc/hosts has a valid
entry for the host name and IP address of the Primary NIC.

On the Tivoli Enterprise Monitoring Server set the
KDCB0_HOSTNAME variable to the primary IP address of the
computer. Use the same address to configure the agent.

To connect to the Tivoli Enterprise Monitoring Server, configure the
agent with the IP address of the Primary NIC or host name of the
computer where the Tivoli Enterprise Monitoring Server is running.

While configuring the agent, make sure that the port number that
you are connecting to is correct. If you are not using the default port
number, make sure that you are using the same port number used in
Tivoli Enterprise Monitoring Server.

For more information, see the IBM Tivoli Monitoring Installation and
Setup Guide.

Agent is behind the Firewall
If you use a Firewall, identify whether you have any one of the
following scenarios:

• Hub monitoring server INSIDE, and agents OUTSIDE
• Hub and remote monitoring servers INSIDE, agents OUTSIDE
• Hub monitoring server INSIDE, remote monitoring server, and

agents OUTSIDE

For information about the KDC_PARTITION file that enables
communication across a firewall, see "Creating a firewall partition
file" in Table 3 on page 15. For more information, see the IBM Tivoli
Monitoring Installation and Setup Guide.

Connecting to the monitoring server through a Virtual Private
Network (VPN)

In some cases, the agent or a remote monitoring server needs to
connect to the hub monitoring server through a VPN. You must
configure the communication channel (pipe) to be ephemeral, as in
the following example:

KDC_FAMILIES=ip.pipe port:port_number 
ephemeral:y ip use:n sna  use:
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Table 7. Agent problems and solutions for the DB2 agent (continued)

Problem Solution

When there are multiple instances
of the DB2 agent in the Tivoli
Enterprise Portal, the status of the
DB2 Server for instances other than
the first one is shown as
"InactiveBusy", and very little data
is displayed in the other
workspaces.

For the DB2 agent to collect data for all of your databases, you must
catalog all of the databases for all of your instances.

Attributes do not allow non-ASCII
input in the Situation Editor.

None. Any attribute that does not include "(Unicode)" might support only
ASCII characters. For example, "Attribute (Unicode)" supports unicode,
but "Attribute" without "(Unicode)" might only support ASCII characters.

Tivoli Enterprise Console events
from IBM Tivoli Monitoring V6.2 for
IBM Tivoli Monitoring v5.x migrated
situations have parsing errors in the
IBM Tivoli Monitoring server.

1. Ensure that you have IBM Tivoli Monitoring V6.2 Event
Synchronization installed on your Tivoli Enterprise Console server.

2. Obtain updated baroc files from the DB2 agent events. The following
updated baroc files are in Tivoli Enterprise Monitoring Server in
install_dir/CMS/TECLIB/itm5migr:

• DB2_Event.baroc
• DB2Agents.baroc
• DB2ApplyReplication.baroc
• DB2BufferPool.baroc
• DB2BufferPoolExtStorage.baroc
• DB2CatalogCache.baroc
• DB2CpuUtilization.baroc
• DB2Cursor.baroc
• DB2DatabaseStatus.baroc
• DB2DirectIO.baroc
• DB2FCMActivity.baroc
• DB2HostThroughput.baroc
• DB2InstanceStatus.baroc
• DB2Locks.baroc
• DB2LockWaits.baroc
• DB2Logging.baroc
• DB2PackageCache.baroc
• DB2ReplicationCapture.baroc
• DB2SAPTablespaceUsageStatus.baroc
• DB2Sorts.baroc
• DB2SQLStatementActivity.baroc
• DB2TableApplyReplication.baroc

You are receiving Tivoli Business
Service Manager events that cannot
be associated because
application_oid and
application_class are not set.

This problem is caused by IBM Tivoli Monitoring V6.2 sending Tivoli
Enterprise Console events for IBM Tivoli Monitoring 5.x migrated
situations. These events are not able to set the cited slot values.
Replace the DB2_send_to_TBSM.sh script on the Tivoli Enterprise
Console server with the version of this file from the Tivoli Enterprise
Monitoring Server in install_dir/CMS/TECLIB/itm5migr.
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Table 7. Agent problems and solutions for the DB2 agent (continued)

Problem Solution

From the Tivoli Enterprise Portal,
stop an agent instance that was
started with the DB2 instance
owner, and start the agent instance
again, the agent is running with the
root user ID instead of the DB2
instance owner.

Follow the reconfiguration steps in the "Reconfiguration, Remote"
procedure in the Installation and Configuration Guide for the agent to
change the user ID with which the agent instance runs to the DB2
instance owner. Recycle the agent instance for the changes to take
effect.

In the kudagent log file, the
following message is repeatedly
displayed:
(4AAE723A.0000-4:khdxhist.cpp,
3673,"readAheadRow") History file 
</opt/IBM/ITMIST/li6263/ud/hist/
db2inst8/KUDDIAGLOG.old> error - 
last row is truncated, 
expected 1705 bytes, 
read 342 bytes, retries = 0.
(4AAE723A.0001-4:khdxhist.cpp,2642
,
"copyHistoryFile")
Found 1 corrupted rows 
for "KUDDIAGLOG". 
Rows were skipped during copying.
(4AAE723A.0002-4:kraahbin.cpp,
498,"WriteRow")
Samples = 10, 
timestamp = 1090914123636
(4AAE723A.0003-4:kraahbin.cpp,
530,"WriteRow")
Wrote 1 rows history data, 
UADVISOR_KUD00_KUDDIAGLOG 
KUD00.KUDDIAGLOG, 
<3633327809,2452621247>

Check the size of the KUDDIAGLOG
historical file, and the file size
exceeds the file size limitation of the
file system. For example, 2G on
xLinux RH4. This problem also
causes high CPU usage, and might
lead to agent crash.

Do the following steps to solve this problem:

1. Remove the historical file whose size exceeds the file size limitation.
2. Change the history collection configuration to reduce the historical

file size:

• Change the value of the Collection Interval attribute to a larger
collection interval. This can be used to reduce the amount of data
that is kept on disk by collecting less historical data. For example,
from the default value of 15 minutes to 1 hour.

• Change the value of the Warehouse Interval attribute to a shorter
retention period. This can be used to reduce the amount of data
that is kept on disk after a successful upload to the warehouse is
performed. For example, from the default value of 1 day to 1 hour.

The DB2 agent on a UNIX or Linux
system does not automatically start
when the UNIX or Linux system
reboots.

The problem occurs because the line that is used to start the agent is
missing from the start up file. To solve this problem, add the following
line in the start up file:

/usr/bin/su - dbinstancename 
-c "ITM_InstalDir/bin/itmcmd agent [-h ITM_InstalDir]
 -o dbinstancename start ud"

32 bit DB2 agents cannot be started
on a 64 bit AIX® 5.3 TL5 system, and
a core dumping occurs in the
$CANDLEHOME/tmp directory.

To solve this problem, upgrade the libc fileset to version 5.3.8.1 or later.

If you do not want to upgrade the libc fileset, see the optional solution at
http://www-01.ibm.com/support/docview.wss?
rs=654&context=SSTFYB&dc=DB560&dc=DB520&uid=swg21366661&
loc=en_US&cs=UTF-8&lang=en&rss=ct654tivoli
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Table 7. Agent problems and solutions for the DB2 agent (continued)

Problem Solution

The DB2 agent fails to monitor 64
bit DB2 databases on Windows
systems, and the following error is
found:
(iradb2agentmain.cpp,236,
"LoadDb2Version")   
 WARNING!!!Windows Registry 
reading of 
Version value failed!!

This problem occurs because the DB2 registry settings are not correct.

To solve this problem, set the registry setting of the
HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\IBM\DB2 entry to
"DB2INSTPROF"="C:\DOCUMENTS AND SETTINGS\ALL USERS
\APPLICATION DATA\IBM\DB2\DB2"

You have chosen to install the DB2
Agent on a windows 64 bit machine
in a directory other than the default
directory. You attempt to open the
Agent log and the following message
is displayed:
4DE4524F.0005-A94:kudprop.cpp,315
,"CPropFile::needLoad")
 Property file C:\IBM\ITMIST\
TMAITM6_x64\
db2lib.properties
 does not exist or not 
accessable.:
 2 No such file or directory.

This problem occurs because the db2lib.properties file is missing from
the CandleHome\TMAITM6_x64\ directory.

To solve this problem create a new text file and name it
db2lib.properties, and then place it in the CandleHome\TMAITM6_x64\
directory.

A memory leak occurs with a long-
running DB2 agent.

The memory leak is for the DB2 server, and is caused when the
monitored DB2 server is one of the following versions:

• DB2 V91 Fix Pack 7
• DB2 V95 Fix Pack 5

Use a different version of the DB2 server to eliminate the memory leak.

You have configured a new instance
of the DB2 instance to monitor a
database instance. You then launch
the Tivoli Enterprise Portal client to
view workspace information.
However when you try to open a
workspace no data is displayed and
instead a message window opens
with the following error message:
SQL1097N  The node name was
 not found
 in the node directory. 
 SQLSTATE=42720' 

The agent log also contains the
same message.

This situation results when in the process of configuring the new agent
instance you enter an incorrect name for the database instance that you
would like to monitor. The agent therefore attempts to monitor a non
existent database instance. To resolve this problem you must re-
configure the agent instance and enter the correct database instance
name.

Manual DB Scripts running steps are
missing in the DB2 agent v7.1
Installation and Configuration
Guide.

From TCR3.1, DB2 agent v7.1 TCR report has to be applied manually to
work. Report installer provided by ITm623 no longer works on TCR3.1.
Below actions should be taken manually which are supposed to be
performed by report installer : 1. Manually import report package from
Web GUI -> instruction available in ITM63 Admin guide. 2. Run db
scripts to create schema and dimension table -> instruction NOT found
in either ITM/TCR or DB2 Agent user guide. 3. Manually create data
source from Web GUI -> -> instruction available in ITM63 Admin guide.
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Table 7. Agent problems and solutions for the DB2 agent (continued)

Problem Solution

Warning messages appears when
upgrading DB2 Agent 7.1 on RHEL
7.3 : cut: fields and positions are
numbered from 1 Try 'cut --help' for
more information. CandleAgent
failure: KCI0766E could not find
arch "" in a JRE version file.

Currency support for RHEL 7.3 is provided from DB2 Agent 7.1.1. So, if
DB2 Agent 7.1 was installed by running "setarch $(uname -m) --
uname-2.6" command prior to installation, this message will appear
when upgrading to 7.1.1. However, this warning is harmless and
expected. So, it can be ignored.

Cannot find 32 bit UD component
after upgrading DB2 Agent 7.1 to
7.1.1 on 64 bit AIX platform.

Both 32 and 64 bit UD components were installed for DB2 Agent 7.1 on
64 bit AIX platform. From DB2 Agent 7.1.1 components are installed
based on machine architecture. So, for 64 bit AIX platform, only 64 bit
UD component will get upgraded to 7.1.1 and 32 bit component will be
removed.

Agent configuration with instance
owner fails in case of installation is
secured by secureMain and agent
configuration is done by root user
for the first time.
The agent configuration fails with
following error:

KCIIN0524E Error attempting to 
build a merge file
java.io.FileNotFoundException:
/opt/IBM/ITM/tmp/.ud.rc 
(Permission denied)
KCIIN0230E Unable to prompt 
for input...

When installation is secured by secureMain, manually assign write
permission to the owner and the db2 admin group for file .ud.rc.

When the Db2 agent is stopped
abruptly, the watchdog process fails
to start the Db2 agent.

Start the Db2 agent manually.

Tivoli Enterprise Portal troubleshooting
Table 8 on page 33 lists problems that might occur with the Tivoli Enterprise Portal. This chapter
provides agent-specific troubleshooting information. See the IBM Tivoli Monitoring Troubleshooting Guide
for general troubleshooting information. 

Table 8. Tivoli Enterprise Portal problems and solutions

Problem Solution

Historical data collection is
unavailable because of
incorrect queries in the
Tivoli Enterprise Portal.

The column, Sort By, Group By, and First/Last functions are not compatible with
the historical data collection feature. Use of these advanced functions will make
a query ineligible for historical data collection.

Even if data collection has been started, you cannot use the time span feature if
the query for the chart or table includes any column functions or advanced query
options (Sort By, Group By, First / Last).

To ensure support of historical data collection, do not use the Sort By, Group By,
or First/Last functions in your queries.

See the IBM Tivoli Monitoring Administrator's Guide for information about the
Historical Data Collection function.

Chapter 3. Problems and workarounds  33



Table 8. Tivoli Enterprise Portal problems and solutions (continued)

Problem Solution

When you use a long
process name in the
situation, the process name
is truncated.

Truncation of process names in the portal display is the expected behavior. 64
bytes is the maximum name length.

In the Network Info
workspace, the value of the
listener port column is 0 or
-1.

Set the svcename parameter as db2c_Instance in the database manager
configuration of the corresponding DB2 database instance. Where Instance is
the name of the DB2 agent instance.

Add the following line in the services file of the DB2 database instance:

db2c_Instance PortNumber/tcp

The services file is located at the following paths:

• Windows systems: %SystemRoot%\system32\drivers\etc\services
• UNIX and Linux systems: /etc/services

After these changes take effect, the specified PortNumber is displayed in the
Network Info workspace.

Troubleshooting for remote deployment
Table 9 on page 34 lists problems that might occur with remote deployment. This section provides
information about troubleshooting remote deployment of the DB2 agent. See the IBM Tivoli Monitoring
Troubleshooting Guide for general troubleshooting information.

This section describes problems and solutions for remote deployment and removal of agent software
Agent Remote Deploy: 

Table 9. Remote deployment problems and solutions

Problem Solution

Remote deploying an instance of the agent on a
Windows 64 bit system in a ITM623FP1
environment using the command line failed with
the following error message: KDY0005E The
component UD is not installed on AC.
The Agent HOSTNAME bundle requires
that this component be present for
the installation to proceed.

1. On the TEMS machine where the DB2 agent bundle was
added, add the KAC bundle version 062301000 into
the TEMS depot from ITM 6.2.3 FP1 from the
WINDOWS images. For example:

• TEMS on Windows :

C:\IBM\ITM> tacmd addbundles -t AC -i
 C:\images\ITM623FP1\WINDOWS\Deploy

• TEMS on Linux :

 /opt/IBM/ITM/bin/tacmd addbundles
 -t AC -i /images/ITM623FP1/WINDOWS/Deploy

2. (Optional) check if there is an orphaned process named
SETUP.EXE running on the OS agent machine and kill
the process.

3. run the tacmd command to remote deploy the DB2
agent again.
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Table 9. Remote deployment problems and solutions (continued)

Problem Solution

After upgrading the agent from version 6.22 fix
pack 1 to version 7.1 on a Linux or a UNIX system,
you restart remote instances of the agent which
connect to ITM version 6.22 fix pack 2
components. The remote instances of the agent
are restarted using the root ID which does not
have the authority to connect to DB2 instances.

You have to define the correct user ID's for the agent
instances in the kcirunas.cfg file. For more information,
see http://publib.boulder.ibm.com/infocenter/tivihelp/
v15r1/topic/com.ibm.itm.doc_6.2.3/
itm623_install226.htm

While you are using the remote deployment
feature to install DB2 agent, an empty command
window is displayed on the target computer. This
problem occurs when the target of remote
deployment is a Windows computer. (See the IBM
Tivoli Monitoring Installation and Setup Guide for
more information on the remote deployment
feature.)

Do not close or modify this window. It is part of the
installation process and will be dismissed automatically.

The removal of a monitoring agent fails when you
use the remote removal process in the Tivoli
Enterprise Portal desktop or browser.

This problem might happen when you attempt the remote
removal process immediately after you have restarted the
Tivoli Enterprise Monitoring Server. You must allow time
for the DB2 agent to refresh its connection with the Tivoli
Enterprise Monitoring Server before you begin the remote
removal process.

You have configured and attempted to deploy a
remote instance of the agent and the operation
has failed. However the Agent Event workspace
does not display information explaining why the
deployment operation failed.

There are a number of reasons that could result in this
problem, to solve the problem you can attempt the
following:

• On Unix or Linux systems, verify that the DB2 instance to
be monitored and the username entered as the DB2
instance owner under Run As both exist on the remote
machine.

• On Windows systems, verify that you are not trying to
deploy a 32 bit agent instance to monitor a 64 bit DB2
instance and that no agent instance of the same name is
already deployed to the remote machine.

If this problem persists, check the ITM logs for more
information.

Workspace troubleshooting
Table 10 on page 35 shows problems that might occur with workspaces. This chapter provides agent-
specific troubleshooting information. See the IBM Tivoli Monitoring Troubleshooting Guide for general
troubleshooting information. 

Table 10. Workspace problems and solutions

Problem Solution

The name of the attribute does not display in a
bar chart or graph view.

When a chart or graph view that includes the attribute is
scaled to a small size, a blank space is displayed instead of a
truncated name. To see the name of the attribute, expand the
view of the chart until there is sufficient space to display all
characters of the attribute's name.
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Table 10. Workspace problems and solutions (continued)

Problem Solution

At the bottom of each view, you see the
following Historical workspace KFWITM220E
error: Request failed during execution

Ensure that you configure all groups that supply data to the
view. In the Historical Configuration view, ensure that data
collection is started for all groups that supply data to the view.

You start collection of historical data but the
data cannot be seen.

Managing options for historical data collection:

• Basic historical data collection populates the Warehouse
with raw data. This type of data collection is turned off by
default. See "Agent-specific installation and configuration
for the monitoring agent" in the Installation and
Configuration Guide for the agent for information about
managing this feature, including how to set the interval at
which data is collected. By setting a more frequent interval
for data collection you reduce the load on the system
incurred every time data is uploaded.

• You use the Summarization and Pruning monitoring agent to
collect specific amounts and types of historical data. Be
aware that historical data is not displayed until the
Summarization and Pruning monitoring agent begins
collecting the data. By default, this agent begins collection
at 2 AM daily. At that point, data is visible in the workspace
view. See the IBM Tivoli Monitoring Administrator's Guide to
learn how to modify the default collection settings.

No data is displayed in the Database
workspace.

The Database workspace only shows the active databases,
which are the databases for which an active connection exists.
The live external connection might be the result of an
application connecting or the result of a db2 connect. Also,
monitoring only occurs for active databases. When the
connection becomes inactive, the database disappears from
the Database workspace, and monitoring stops for this
database.

DB2 workspaces become empty with a busy
hourglass for a while, when the DB2 agent is
monitoring a partitioned DB2 database.

This problem occurs because a DB2 partition is unavailable,
and there isDB2 time-out and retry activities.

When a partition is unavailable, the duration after which the
error status is returned is determined by the Fast
Communications Manager (FCM) settings, which include the
max_connretries parameter (Node connection retries) with
the default value of 5 retries, and the conn_elapse parameter
(Connection elapse time) with the default value of 10
seconds. When the default values of the two parameters are
used, there is a 50-second delay for each DB2 API call while
there are a lot of API requests for the agent to make. In this
period of time, the workspaces are empty with a busy
hourglass.

To reduce the empty workspace time, you can set a smaller
value for the max_connretries parameter or the conn_elapse
parameter.

36  IBM Tivoli Composite Application Manager Agent for DB2: ITCAM Agent for DB2 Troubleshooting Guide



Table 10. Workspace problems and solutions (continued)

Problem Solution

If Customized SQL query contains the "order
by" clause, then the relevant workspace does
not show data and the DB2 server logs the
following error in log file.

The statement or command failed
because it requires functionality
that is not supported on a read-
enabled HADR standby database.
Reason code = "5".

DB2 v11.1.0.0 server, or below does not support order by
clause on standby. Hence DB2 agent cannot collect data for
customized SQL workspace.

To overcome this problem upgrade to DB2 v11.1.2.2 server
that provides support for "order by" clause on standby. For
more information, see

http://www-01.ibm.com/support/docview.wss?
uid=swg1IT22612

The Diagnostic Messages workspace for the
DB2 Diagnostic Log attribute group displays
timestamps as date and time string instead of
date and time format.

For example, it displays 117111619015600
instead of 11/16/2017 19:01:56.

No workaround available for this problem currently.

The date and time string can be interpreted as:

117111619015600 - YYYMMDDhhmmss

Situation troubleshooting
This section provides information about both general situation problems and problems with the
configuration of situations. See the IBM Tivoli Monitoring Troubleshooting Guide for more information
about troubleshooting for situations.

Situation troubleshooting
Problems can occur with situations and situation configuration.

Table 11 on page 37 contains problems and solutions for situations.

Table 11. Situation problems and solutions

Problem Solution

Monitoring activity requires too much disk space. Check the RAS trace logging settings that are
described in “Setting RAS trace parameters by
using the GUI” on page 8. For example, trace logs
grow rapidly when you apply the ALL logging
option.

Monitoring activity requires too many system
resources.

See the information about disk capacity planning
for historical data in the Reference guide for the
agent for a description of the performance impact
of specific attribute groups. If possible, decrease
your use of the attribute groups that require
greater system resources.

A formula that uses mathematical operators
appears to be incorrect. For example, if you were
monitoring a Linux system, the formula that
calculates when Free Memory falls under 10
percent of Total Memory does not work: LT
#'Linux_VM_Stats.Total_Memory' / 10

This formula is incorrect because situation
predicates support only logical operators. Your
formulas cannot have mathematical operators.

Note: The Situation Editor provides alternatives to
math operators. In the example, you can select the
% Memory Free attribute and avoid the need for
math operators.
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Table 11. Situation problems and solutions (continued)

Problem Solution

You want to change the appearance of situations
when they are displayed in the navigation tree.

1. Right-click an item in the navigation tree.
2. Click Situations in the menu. The Situation

Editor window is displayed.
3. Select the situation that you want to modify.
4. Use the State menu to set the status and

appearance of the Situation when it triggers.

Note: The State setting is not related to
severity settings in the Tivoli Enterprise
Console.

When a situation is triggered in the Event Log
attribute group, it remains in the Situation Event
Console as long as the event ID entry is present in
the Event Log workspace. When this event ID entry
is removed from the Event Log workspace on the
Tivoli Enterprise Portal, the situation is also cleared
even if the actual problem that caused the event is
not resolved, and the event ID entry is also present
in the Windows Event Viewer.

A timeout occurs on the cache of events for the NT
Event Log group. Increase the cache time of Event
Log collection to meet your requirements by
adding the following variable and timeout value to
the KpcENV file for the agent (where pc is the two-
letter product code):
CDP_NT_EVENT_LOG_CACHE_TIMEOUT=3600

This variable determines how long events from the
NT Event Log are kept.

The situation for a specific agent is not visible in
the Tivoli Enterprise Portal.

Open the Situation Editor. Access the All managed
servers view. If the situation is not displayed,
confirm that the monitoring server has been
seeded for the agent. If not, seed the server, as
described in the IBM Tivoli Monitoring Installation
and Setup Guide.

The monitoring interval is too long. Access the Situation Editor view for the situation
that you want to modify. Check the Sampling
interval area in the Formula tab. Adjust the time
interval as required.

The situation did not activate at startup. Manually recycle the situation as follows:

1. Right-click the situation and select Stop
Situation.

2. Right-click the situation and select Start
Situation.

Note: You can permanently avoid this problem by
selecting the Run at Startup check box of the
Situation Editor view for a specific situation.

The situation is not displayed. Click the Action tab and check whether the
situation has an automated corrective action. This
action can occur directly or through a policy. The
situation might be resolving so quickly that you do
not see the event or the update in the graphical
user interface.

An Alert event did not occur even though the
predicate was correctly specified.

Check the logs, reports, and workspaces.
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Table 11. Situation problems and solutions (continued)

Problem Solution

A situation fires on an unexpected managed object. Confirm that you distributed and started the
situation on the correct managed system.

The product did not distribute the situation to a
managed system.

Click the Distribution tab and check the
distribution settings for the situation.

The situation does not fire. This problem can be caused when incorrect
predicates are present in the formula that defines
the situation. For example, the managed object
shows a state that normally triggers a monitoring
event, but the situation is not true because the
wrong attribute is specified in the formula.

In the Formula tab, analyze predicates as follows:

1. Click the fx icon in the Formula area. The Show
formula window is displayed.

a. Confirm the following details in the Formula
area of the window:

• The attributes that you intend to monitor
are specified in the formula.

• The situations that you intend to monitor
are specified in the formula.

• The logical operators in the formula match
your monitoring goal.

• The numeric values in the formula match
your monitoring goal.

b. (Optional) Select the Show detailed formula
check box to see the original names of
attributes in the application or operating
system that you are monitoring.

c. Click OK to dismiss the Show formula
window.

2. (Optional) In the Formula area of the Formula
tab, temporarily assign numeric values that
immediately trigger a monitoring event. The
triggering of the event confirms that other
predicates in the formula are valid.

Note: After you complete this test, you must
restore the numeric values to valid levels so
that you do not generate excessive monitoring
data based on your temporary settings.

For additional information about situations that do
not fire, see "Situations are not firing" in the IBM
Tivoli Monitoring Troubleshooting Guide.

Situation events are not displayed in the Events
Console view of the workspace.

Associate the situation with a Navigator item.

Note: The situation does not need to be displayed
in the workspace. It is sufficient that the situation
is associated with any Navigator item.

Chapter 3. Problems and workarounds  39



Table 11. Situation problems and solutions (continued)

Problem Solution

You do not have access to a situation. Note: You must have administrator privileges to
complete these steps.

1. Click Edit > Administer Users to access the
Administer Users window.

2. In the Users area, select the user whose
privileges you want to modify.

3. In the Permissions tab, Applications tab, and
Navigator Views tab, select the permissions or
privileges that correspond to the user role.

4. Click OK.

A managed system seems to be offline. 1. Select Physical View and click the Enterprise
Level of the navigator tree.

2. Click View > Workspace > Managed System
Status to see a list of managed systems and
their status.

3. If a system is offline, check network
connectivity and the status of the specific
system or application.

Consider performance impact of each attribute group

Table 12 on page 40 lists the impact on performance (high, medium, or low) of each attribute group. The
multiple-instance attributes have been classified at the lowest level. That is, the performance overhead
will increase if you do not specify compare values for one or more key values.

When you want to prevent impact on performance by any of the attribute groups listed in Table 12 on
page 40 you must avoid referencing that attribute group, as suggested in this list:

• Disable the attribute group.
• Never select workspaces that reference the attribute group.
• Disable situations that reference the attribute group by using the "Undistributed situations" option in

the Situation Editor.
• Disable historical reporting that references the attribute group.
• Avoid using the "Auto Refresh" refresh feature in a Workspace because this option causes a refresh of

data for all attribute groups.

See the IBM Tivoli Monitoring User's Guide for additional information on controlling attribute group usage.

Table 12. Performance impact by attribute group

Attribute group High Medium Low

Application00 (KUD_DB2_Application00 ✓

Application00 (KUDDB2APPLGROUP00)
(Superseded)

✓

Application00U (KUDDB2APPLGROUP00_U)
(Superseded)

✓

Application01 (KUD_DB2_Application01) ✓
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Table 12. Performance impact by attribute group (continued)

Attribute group High Medium Low

Application01 (KUDDB2APPLGROUP01)
(Superseded)

✓

Apply Program (KUD_DB2_Apply_Program) ✓

Apply Subscription (KUD_DB2_Apply_Subscription) ✓

Buffer Pool (KUD_DB2_Buffer_Pool) ✓

Buffer Pool (KUDBUFFERPOOL00) (Superseded) ✓

Database00 (KUD_DB2_Database00) ✓

Database00 (KUDDBASEGROUP00) (Superseded) ✓

Database01 (KUD_DB2_Database01) ✓

Database01 (KUDDBASEGROUP01) (Superseded) ✓

Database02 (KUD_DB2_Database02) ✓

DCS Database (KUD_DB2_DCS_Database) ✓

Diagnostic Log (KUD_DB2_Diagnostic_Log) ✓

Diagnostic Messages
(KUD_DB2_Diagnostic_Messages) (Superseded)

✓

Locking Conflict (KUDLOCKCONFLICT00) ✓

Log (KUD_DB2_LOG) ✓

Log Record (KUD_DB2_LOG_RECORD) ✓

Network Info (KUD_DB2_IPADDR_TABLE) ✓

System Overview (KUD_DB2_System_Overview) ✓

System Overview (KUDINFO00) (Superseded) ✓

System Resources (KUD_DB2_System_Resources) ✓

Table (KUD_DB2_Table) ✓

Tablespace (KUD_DB2_Tablespace) ✓

Tablespace (KUDTABSPACE) (Superseded) ✓

Problems with configuration of situations
Table 13 on page 42 lists problems that might occur with situations.

This section provides information for troubleshooting for agents. Be sure to consult the IBM Tivoli
Monitoring Troubleshooting Guide for more general troubleshooting information.
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Table 13. Problems with configuring situations that you solve in the Situation Editor

Problem Solution

Remember: To get started with the solutions in this section, perform these steps:

1. Launch the Tivoli Enterprise Portal.
2. Click Edit > Situation Editor.
3. In the tree view, choose the agent whose situation you want to modify.
4. Choose the situation in the list. The Situation Editor view is displayed.

The situation for a specific agent
is not visible in the Tivoli
Enterprise Portal.

Open the Situation Editor. Access the All managed servers view. If the
situation is absent, confirm that application support for DB2 agent has been
added to the monitoring server. If not, add application support to the server,
as described in the IBM Tivoli Monitoring Installation and Setup Guide.

The monitoring interval is too
long.

Access the Situation Editor view for the situation that you want to modify.
Check the Sampling interval area in the Formula tab. Adjust the time
interval as needed.

The situation did not activate at
startup.

Recycle the situation as follows:

1. Right-click the situation and choose Stop Situation.
2. Right-click the situation and choose Start Situation.

Tip: You can permanently avoid this problem by placing a check mark in the
Run at Startup option of the Situation Editor view for a specific situation.

The situation is not displayed. Click the Action tab and check whether the situation has an automated
corrective action. This action can occur directly or through a policy. The
situation might be resolving so quickly that you do not see the event or the
update in the graphical user interface.

An Alert event has not occurred
even though the predicate has
been properly specified.

Check the logs, reports, and workspaces.

A situation fires on an
unexpected managed object.

Confirm that you have distributed and started the situation on the correct
managed system.

The product did not distribute
the situation to a managed
system.

Click the Distribution tab and check the distribution settings for the
situation.
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Table 13. Problems with configuring situations that you solve in the Situation Editor (continued)

Problem Solution

The situation does not fire.

Incorrect predicates are present
in the formula that defines the
situation. For example, the
managed object shows a state
that normally triggers a
monitoring event, but the
situation is not true because the
wrong attribute is specified in
the formula.

In the Formula tab, analyze predicates as follows:

1. Click the fx icon in the upper-right corner of the Formula area. The Show
formula window is displayed.

a. Confirm the following details in the Formula area at the top of the
window:

• The attributes that you intend to monitor are specified in the
formula.

• The situations that you intend to monitor are specified in the
formula.

• The logical operators in the formula match your monitoring goal.
• The numerical values in the formula match your monitoring goal.

b. (Optional) Click the Show detailed formula check box in the lower
left of the window to see the original names of attributes in the
application or operating system that you are monitoring.

c. Click OK to dismiss the Show formula window.
2. (Optional) In the Formula area of the Formula tab, temporarily assign

numerical values that will immediately trigger a monitoring event. The
triggering of the event confirms that other predicates in the formula are
valid.

Remember: After you complete this test, you must restore the numerical
values to valid levels so that you do not generate excessive monitoring
data based on your temporary settings.

Table 14. Problems with configuration of situations that you solve in the Workspace area

Problem Solution

Situation events are not
displayed in the Events Console
view of the workspace.

Associate the situation with a workspace.

The situation does not need to be displayed in the workspace. It is sufficient
that the situation is associated with any workspace.

You do not have access to a
situation.

Important: You must have administrator privileges to perform these steps.

1. Select Edit > Administer Users to access the Administer Users window.
2. In the Users area, select the user whose privileges you want to modify.
3. In the Permissions tab, Applications tab, and Navigator Views tab, select

the permissions or privileges that correspond to the user's role.
4. Click OK.

A managed system seems to be
offline.

1. Select Physical View and highlight the Enterprise Level of the navigator
tree.

2. Select View > Workspace > Managed System Status to see a list of
managed systems and their status.

3. If a system is offline, check network connectivity and status of the
specific system or application.
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Table 15. Problems with configuration of situations that you solve in the Manage Tivoli Enterprise Monitoring
Services window

Problem Solution

After an attempt to restart the
agents in the Tivoli Enterprise
Portal, the agents are still not
running.

For UNIX, NetWare, or Windows systems, log on to the applicable system
and perform the appropriate queries.

The Tivoli Enterprise Monitoring
Server is not running.

Check the system status and check the appropriate IBM Tivoli Monitoring
logs.

The managed objects you
created are firing on incorrect
managed systems.

Check the managed system distribution on both the situation and the
managed object settings sheets.

For agents that can have multiple subnodes, such as database agents:

The icon is incorrect. Check the icon assignments in the template.

The situation is not assigned to a
state in the template.

Check the situation assignments in the template of the associated managed
object.

You assigned the situation to an
incorrect state in the template.

Check the State settings sheet for the template.

Take Action command troubleshooting
Table 16 on page 44 lists general problems that might occur with Take Action commands. When each
Take Action command runs it generates the log file listed in “Principal trace log files” on page 4. This
chapter provides agent-specific troubleshooting information. See the IBM Tivoli Monitoring
Troubleshooting Guide for general troubleshooting information.

Table 16. Take Action commands problems and solutions

Problem Solution

Some Take Action commands require several
minutes to complete.

Allow several minutes. If you do not see a pop-up message
advising you of completion, try to run the command manually.
Consult the log file for the Take Action command, name.log,
where name is the name of the Take Action command.

Take Action commands work only when all the
argument values are specified.

Set the values of the arguments that you do not need as None.
Do not left any argument value blank.
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Chapter 4. Support information
If you have a problem with your IBM software, you want to resolve it quickly.

IBM provides the following ways for you to obtain the support you need:
Online

The following websites contain troubleshooting information:

• Go to the IBM Software Support website (http://www.ibm.com/support/entry/portal/software) and
follow the instructions.

• Go to the Application Performance Management Wiki (http://www.ibm.com/developerworks/
servicemanagement/apm/index.html). Feel free to contribute to this wiki.

IBM Support Assistant
The IBM Support Assistant (ISA) is a free local software serviceability workbench that helps you
resolve questions and problems with IBM software products. The ISA provides quick access to
support-related information and serviceability tools for problem determination. To install the ISA
software, go to the IBM Support Assistant website (http://www.ibm.com/software/support/isa).
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Chapter 5. Informational, warning, and error
messages overview

Messages relay information about how the system or application is performing and can alert you to
exceptional conditions when they occur.

Messages are sent to an output destination, such as a file, database, or console screen.

If you receive a warning or error message, you can do one of the following actions:

• Follow the instructions listed in the Detail window of the message if this information is included there.
• Consult the message details listed in this topic to see what action you can take to correct the problem.
• Consult the message log for message ID, text, time, and date of the message, as well as other data you

can use to diagnose the problem.

Message format
The message format contains a message ID and text, an explanation, and an operator response.

Agent messages have the following format:

Message ID and text
Explanation
Operator Response

The message ID has the following format:

CCC####severity

where:
CCC

Prefix that indicates the component to which the message applies. The following components are
used:
KXX

Three-character product code for the agent.
####

Number of the message
severity

Severity of the message. Three levels of severity are used:
I

Informational messages provide feedback about something that happened in the product or
system that might be important. These messages can provide guidance when you are
requesting a specific action from the product.

W
Warning messages call your attention to an exception condition. The condition might not be an
error but can cause problems if not resolved.

E
Error messages indicate that an action cannot be completed because of a user or system
error. These messages require user response.

The Text of the message provides a general statement regarding the problem or condition that occurred.
The Explanation provides additional information about the message and the possible cause for the
condition. The Operator Response provides actions to take in response to the condition, particularly for
error messages (messages with the "E" suffix).
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Note: Many message texts and explanations contain variables, such as the specific name of a server or
application. Those variables are represented in this topic as symbols, such as "&1." Actual messages
contain values for these variables.
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Appendix A. ITCAM for Applications documentation
library

Various publications are relevant to the use of ITCAM for Applications.

For information about how to access and use the publications, see Using the publications (http://
pic.dhe.ibm.com/infocenter/tivihelp/v61r1/topic/com.ibm.itm.doc_6.3/common/
using_publications.htm).

To find publications from the previous version of a product, click Previous versions under the name of the
product in the Contents pane.

Documentation for this product is in the ITCAM for Applications Information Center (http://
publib.boulder.ibm.com/infocenter/tivihelp/v24r1/topic/com.ibm.itcama.doc_7.2.1/
welcome_apps721.html):

• Quick Start Guide
• Offering Guide
• Download instructions
• Links to Prerequisites
• Installation and Configuration Guide for each agent
• Link to Reference information for each agent
• Link to Troubleshooting Guide for each agent

Prerequisite publications
To use the information about the agents effectively, you must have some prerequisite knowledge.

See the following information at the IBM Tivoli Monitoring Information Center (http://pic.dhe.ibm.com/
infocenter/tivihelp/v61r1/index.jsp) to gain prerequisite knowledge:

• IBM Tivoli Monitoring Administrator's Guide
• IBM Tivoli Monitoring Installation and Setup Guide
• IBM Tivoli Monitoring High Availability Guide for Distributed Systems
• IBM Tivoli Monitoring: Installation and Configuration Guides for the following agents: Operating System

agents and Warehouse agents
• IBM Tivoli Monitoring: User's Guides for the following agents: Agentless OS monitors, Log file agent,

System p agents, Systems Director base agent
• IBM Tivoli Monitoring Agent Builder User's Guide
• IBM Tivoli Monitoring Command Reference
• IBM Tivoli Monitoring: Messages
• IBM Tivoli Monitoring Troubleshooting Guide
• IBM Tivoli Monitoring: References for the following agents: Operating System agents and Warehouse

agents
• IBM Tivoli Monitoring: Troubleshooting Guides for the following agents: Operating System agents and

Warehouse agents
• Tivoli Enterprise Portal User's Guide
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Related publications
The publications in related information centers provide useful information.

See the following information centers, which you can find by accessing Tivoli Documentation Central
(https://www.ibm.com/developerworks/community/wikis/home?lang=en#!/wiki/Tivoli
%20Documentation%20Central):

• Tivoli Monitoring
• Tivoli Application Dependency Discovery Manager
• Tivoli Business Service Manager
• Tivoli Common Reporting
• Tivoli Enterprise Console
• Tivoli Netcool/OMNIbus

Tivoli Monitoring Community on Service Management Connect
Service Management Connect (SMC) is a repository of technical information that is organized by
communities.

Access Service Management Connect at https://www.ibm.com/developerworks/servicemanagement.

For information about Tivoli products, see the Application Performance Management community (http://
www.ibm.com/developerworks/servicemanagement/apm/index.html).

Connect, learn, and share with Service Management professionals. Get access to developers and product
support technical experts who provide their perspectives and expertise. You can use SMC for these
purposes:

• Become involved with transparent development, an ongoing, open engagement between other users
and IBM developers of Tivoli products. You can access early designs, sprint demonstrations, product
roadmaps, and prerelease code.

• Connect one-on-one with the experts to collaborate and network about Tivoli and the Application
Performance Management community.

• Read blogs to benefit from the expertise and experience of others.
• Use wikis and forums to collaborate with the broader user community.

Other sources of documentation
You can obtain additional technical documentation about monitoring products from other sources.

See the following sources of technical documentation about monitoring products:

• IBM Integrated Service Management Library (http://www.ibm.com/software/brandcatalog/ismlibrary/)
is an online catalog that contains integration documentation as well as other downloadable product
extensions.

• IBM Redbook publications (http://www.redbooks.ibm.com/) include Redbooks® publications,
Redpapers, and Redbooks technotes that provide information about products from platform and
solution perspectives.

• Technotes (http://www.ibm.com/support/entry/portal/software), which are found through the IBM
Software Support website, provide the latest information about known product limitations and
workarounds.
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Notices

This information was developed for products and services offered in the U.S.A. IBM may not offer the
products, services, or features discussed in this document in other countries. Consult your local IBM
representative for information on the products and services currently available in your area. Any
reference to an IBM product, program, or service is not intended to state or imply that only that IBM
product, program, or service may be used. Any functionally equivalent product, program, or service that
does not infringe any IBM intellectual property right may be used instead. However, it is the user's
responsibility to evaluate and verify the operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter described in this
document. The furnishing of this document does not give you any license to these patents. You can send
license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation
North Castle Drive
Armonk, NY 10504-1785 U.S.A.

For license inquiries regarding double-byte (DBCS) information, contact the IBM Intellectual Property
Department in your country or send inquiries, in writing, to:

Intellectual Property Licensing
Legal and Intellectual Property Law
IBM Japan Ltd.
19-21, Nihonbashi-Hakozakicho, Chuo-ku
Tokyo 103-8510, Japan

The following paragraph does not apply to the United Kingdom or any other country where such
provisions are inconsistent with local law:

INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS PUBLICATION "AS IS"
WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO,
THE IMPLIED WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A
PARTICULAR PURPOSE.

Some states do not allow disclaimer of express or implied warranties in certain transactions, therefore,
this statement might not apply to you.

This information could include technical inaccuracies or typographical errors. Changes are periodically
made to the information herein; these changes will be incorporated in new editions of the publication.
IBM may make improvements and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for convenience only and do not in
any manner serve as an endorsement of those Web sites. The materials at those Web sites are not part of
the materials for this IBM product and use of those Web sites is at your own risk.

IBM may use or distribute any of the information you supply in any way it believes appropriate without
incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose of enabling: (i) the
exchange of information between independently created programs and other programs (including this
one) and (ii) the mutual use of the information which has been exchanged, should contact:

IBM Corporation
2Z4A/101
11400 Burnet Road
Austin, TX  78758     U.S.A.
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Such information may be available, subject to appropriate terms and conditions, including in some cases
payment of a fee.

The licensed program described in this document and all licensed material available for it are provided by
IBM under terms of the IBM Customer Agreement, IBM International Program License Agreement or any
equivalent agreement between us.

Any performance data contained herein was determined in a controlled environment. Therefore, the
results obtained in other operating environments may vary significantly. Some measurements may have
been made on development-level systems and there is no guarantee that these measurements will be the
same on generally available systems. Furthermore, some measurement may have been estimated
through extrapolation. Actual results may vary. Users of this document should verify the applicable data
for their specific environment.

Information concerning non-IBM products was obtained from the suppliers of those products, their
published announcements or other publicly available sources. IBM has not tested those products and
cannot confirm the accuracy of performance, compatibility or any other claims related to non-IBM
products. Questions on the capabilities of non-IBM products should be addressed to the suppliers of
those products.

All statements regarding IBM's future direction or intent are subject to change or withdrawal without
notice, and represent goals and objectives only.

All IBM prices shown are IBM's suggested retail prices, are current and are subject to change without
notice. Dealer prices may vary.

This information is for planning purposes only. The information herein is subject to change before the
products described become available.

This information contains examples of data and reports used in daily business operations. To illustrate
them as completely as possible, the examples include the names of individuals, companies, brands, and
products. All of these names are fictitious and any similarity to the names and addresses used by an
actual business enterprise is entirely coincidental.

COPYRIGHT LICENSE:

This information contains sample application programs in source language, which illustrate programming
techniques on various operating platforms. You may copy, modify, and distribute these sample programs
in any form without payment to IBM, for the purposes of developing, using, marketing or distributing
application programs conforming to the application programming interface for the operating platform for
which the sample programs are written. These examples have not been thoroughly tested under all
conditions. IBM, therefore, cannot guarantee or imply reliability, serviceability, or function of these
programs. You may copy, modify, and distribute these sample programs in any form without payment to
IBM for the purposes of developing, using, marketing, or distributing application programs conforming to
IBM‘s application programming interfaces.

Each copy or any portion of these sample programs or any derivative work, must include a copyright
notice as follows:
© IBM 2009. Portions of this code are derived from IBM Corp. Sample Programs. © Copyright IBM Corp.
2009. All rights reserved.

If you are viewing this information in softcopy form, the photographs and color illustrations might not be
displayed.

Trademarks
IBM, the IBM logo, and ibm.com® are trademarks or registered trademarks of International Business
Machines Corp., registered in many jurisdictions worldwide. Other product and service names might be
trademarks of IBM or other companies. A current list of IBM trademarks is available on the web at
Copyright and trademark information (www.ibm.com/legal/copytrade.shtml).
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Java™ and all Java-based trademarks and logos are trademarks or registered trademarks of Oracle and/or
its affiliates.

Linux is a registered trademark of Linus Torvalds in the United States, other countries, or both.

Microsoft and Windows are trademarks of Microsoft Corporation in the United States, other countries, or
both.

UNIX is a registered trademark of The Open Group in the United States and other countries.

Other company, product, or service names may be trademarks or service marks of others.

Privacy policy considerations
IBM Software products, including software as a service solutions, ("Software Offerings") may use cookies
or other technologies to collect product usage information, to help improve the end user experience, to
tailor interactions with the end user or for other purposes. In many cases no personally identifiable
information is collected by the Software Offerings. Some of our Software Offerings can help enable you to
collect personally identifiable information. If this Software Offering uses cookies to collect personally
identifiable information, specific information about this offering’s use of cookies is set forth below.

Depending upon the configurations deployed, this Software Offering may use session cookies that collect
each user’s user name for purposes of session management, authentication, and single sign-on
configuration. These cookies cannot be disabled.

If the configurations deployed for this Software Offering provide you as customer the ability to collect
personally identifiable information from end users via cookies and other technologies, you should seek
your own legal advice about any laws applicable to such data collection, including any requirements for
notice and consent.

For more information about the use of various technologies, including cookies, for these purposes, See
IBM’s Privacy Policy at http://www.ibm.com/privacy and IBM’s Online Privacy Statement at http://
www.ibm.com/privacy/details the section entitled "Cookies, Web Beacons and Other Technologies" and
the "IBM Software Products and Software-as-a-Service Privacy Statement" at http://www.ibm.com/
software/info/product-privacy.
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